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Preface
This preface describes the document accessibility features and conventions used in this
guide–Smart Update Applying Patches to Oracle WebLogic Server.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.
Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Related Documents
For more information, see the following documents in the Oracle Fusion Middleware
11g Release 1 documentation set:
■

Installation Guide for Oracle WebLogic Server

■

Document ID 1294294.1 on My Oracle Support

■

Document ID 1302053.1 on My Oracle Support

Conventions
The following text conventions are used in this document:
Convention

Meaning

boldface

Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic

Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace

Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Introduction

1

This section contains the following topics:
■

Section 1.1, "What is New in Smart Update Version 3.3.0"

■

Section 1.2, "Products Supported by Smart Update Version 3.3.0"

■

Section 1.3, "Downloading and Installing Smart Update 3.3.0"

■

Section 1.4, "Quick Reference Information"

■

Section 1.5, "How Smart Update Simplifies Patch Management"

■

Section 1.6, "Resources Available from My Oracle Support"

■

Section 1.7, "Overview of Applying Patches"

1.1 What is New in Smart Update Version 3.3.0
As of Smart Update 3.3.0, the Get Patches tab has been removed, and you can no
longer use Smart Update to download patches, service packs, maintenance packs, or
version upgrades. You must first download the appropriate patch or patches directly
from My Oracle Support. Once downloaded, you can use Smart Update to apply the
patches.
You can use Smart Update 3.3.0 only to install patches. You cannot use Smart Update
3.3.0 to install service packs, maintenance packs, or version upgrades. To upgrade a
version of an installed product, you must download an Upgrade installer from My
Oracle Support and run the installer independently of Smart Update. For more
detailed information, enter the following document ID in the Knowledge Base search
filed on My Oracle Support:
1294294.1
Smart Update 3.3.0 no longer prompts you to register for security updates from Oracle
Configuration Management (OCM). OCM registration for security updates is still
available when installing WebLogic Server or using an Upgrade installer to upgrade
an existing WebLogic Server installation to version 10.3.2 or higher. OCM registration
is also available directly from My Oracle Support by selecting the Collector tab from
any My Oracle Support page.
For information about limitations of Smart Update, see Chapter 10, "Known
Limitations in Smart Update."

1.2 Products Supported by Smart Update Version 3.3.0
You can use Smart Update 3.3.0 to apply patches for the following products:
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■

Oracle WebLogic Server 9.1.0, 9.2.0, 9.2.1, 9.2.2, 9.2.3, 9.2.4, 10.0.0, 10.0.1, 10.0.2,
10.3.0, 10.3.1, 10.3.2, 10.3.3, 10.3.4, 10.3.5, 10.3.6, 12.1.1

■

Oracle Workshop for WebLogic Platform 9.2.1, 9.2.2, 9.2.3, 10.0, 10.0.1

■

Oracle Workshop 10.1.0, 10.2.0, 10.2.1, 10.3.0, 10.3.1

■

Oracle WorkSpace Studio 1.1.0

■

Oracle WebLogic Integration 9.2.0, 9.2,1, 9.2.2, 9.2.3, 10.2.0, 10.2.1, 10.3.0, 10.3.1

■

Oracle WebLogic Portal 9.2.0, 9.2,1, 9.2.2, 9.2.3, 10.0.0. 10.0.1, 10.2.0, 10.2.1, 10.3.0,
10.3.2

■

Oracle WebLogic Event Server 2.0.0

■

Oracle Complex Event Processing 10.3.0, 11.1.1.1, 11.1.2.0, 11.1.3.0, 11.1.4.0

■

Oracle WebLogic Operations Control 1.0.0, 10.3.0

■

Oracle Communications Converged Application Server 5.0

■

Oracle Communications Services Gatekeeper 4.1.0, 4.1.1, 5.0.0

■

Oracle Service Bus 10.3.0, 10.3.1

■

Aqualogic Service Bus 2.1, 2.5, 2.6, 2.6 RPI, 3.0

■

Oracle AquaLogic Data Services Platform 3.2.0

■

Oracle AquaLogic Enterprise Repository 3.0.0

■

Oracle Communications Marketing and Advertising 5.0.0.1

■

Oracle Communications Presence 5.0.0

■

Oracle Data Service Integrator 10.3.0

■

Oracle WebLogic Communications Services 10.3.1

■

Oracle WebLogic Communications Server 10.3.0

■

Oracle WebLogic Network Gatekeeper 4.0.0

1.3 Downloading and Installing Smart Update 3.3.0
Systems with internet access will automatically be updated to Smart Update 3.3.0.
To update offline machines:
1.

Download patch 12426828 from My Oracle Support to a system with internet
access.

2.

Extract the downloaded ZIP file to a directory. The ZIP file contains a standalone
installer for Smart Update 3.3.0.

3.

Refer to the instructions in the patch README file for patch 12426828. If you want
to install Smart Update in silent mode, see the next section.

1.3.1 Installing Smart Update 3.3.0 in Silent Mode
If you want to use silent mode to install Smart Update 3.3.0, after extracting the
downloaded the ZIP file, complete the following steps:
1.

Create a silent installation XML file (for example, silent.xml) with the
following contents and store it in the same directory in which the Smart Update
3.3.0 installer is located:
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<?xml version="1.0" encoding="UTF-8"?>
<domain-template-descriptor>
<input-fields>
<data-value name="BEAHOME" value="MW_HOME" />
<data-value name="COMPONENT_PATHS" value="Common Infrastructure
Engineering|Oracle WebLogic Smart Update" />
</input-fields>
</domain-template-descriptor>

For the BEAHOME data value, replace MW_HOME with your Middleware Home
directory (for example, C:\Oracle\Middleware).
2.

Open a command prompt window.

3.

Enter the following command:
java -jar patch-client-installer330_generic32.jar
-mode=silent -silent_xml=xml_file_name
Replace xml_file_name with the name of your silent installation XML file.

For more information on silent mode installation, refer to the WebLogic Server
installation guide for your WebLogic Server version.

1.4 Quick Reference Information
To start using Smart Update right away, refer to the sections listed in Table 1–1. These
sections summarize the steps required to perform basic Smart Update tasks.
Table 1–1

Smart Update Quick Reference Information

Quick Reference Information

Contents

Section A.1, "How to Generate
a Maintenance Snapshot"

Procedure for creating a maintenance snapshot, a simple text
file containing detailed information about the maintenance
level of the product installation. This file is requested by My
Oracle Support whenever you contact them for assistance.

Section A.2, "How to Create a
Custom Patch Profile"

Procedure for creating a custom patch profile, which you use to
point an individual WebLogic domain or one or more servers
at patches that are not intended to be in effect for all servers
that run on the product installation.

Section A.3, "Smart Update
GUI Glossary"

Definitions of the icons and labels used in the Smart Update
graphical interface.

Section 8.2, "bsu Command
Reference"

Reference for the bsu command, the Smart Update
command-line interface to Smart Update.

1.5 How Smart Update Simplifies Patch Management
Smart Update is a standalone Java application that you can run independently of any
software to apply available patches to your current software installations quickly and
easily. You can use it to apply patches that you download from My Oracle Support.
When you install a product for the first time, Smart Update is automatically installed
in MW_HOME/utils/bsu.
Smart Update is enhanced from time to time with new features, and is made available
on My Oracle Support as a patch. For more information, see Section 1.3, "Downloading
and Installing Smart Update 3.3.0."
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When you start Smart Update at a later point, the updated version is invoked.

1.5.1 Patch Validation and Conflict Checking
Each patch created for a particular version of a product is validated against all existing
patches for that version. When you run Smart Update to view downloaded patches,
you automatically leverage the validation data provided by My Oracle Support to
eliminate the chances of applying a patch with a known conflict with any other patch
that has been properly applied to the product installation.
For example, when you attempt to apply one patch that depends on another that has
not been applied, Smart Update notifies you of the dependency. You can download the
prerequisite patch from My Oracle Support and then use Smart Update to apply it
before proceeding. Patch validation is performed automatically whenever you apply a
patch.
Occasionally My Oracle Support may provide a replacement for a patch, or invalidate
a patch, that you have previously applied. When you download any patch from My
Oracle Support, the patch contains a copy of the patch catalog, which reflects the
current state of the Smart Update repository. Therefore, after downloading a patch,
you may notice that you have obsolete patches installed. If this happens, check My
Oracle Support for the replacement to the obsolete patch.

1.5.2 Command-Line Interface
A command-line interface to Smart Update enables you to apply patches and obtain
information about patches that have been downloaded or applied. You can perform
these functions directly, from the command line, or indirectly, by writing scripts that
include Smart Update commands.

1.5.3 Support for Distributed Patching
Smart Update supports a model in which patches that you have downloaded from My
Oracle Support to a central location in an organization can be distributed through a
script to machines in a production environment on which products have been
installed. This model enables you to adapt Smart Update to your business practices
that govern how patches are distributed and applied to machines, especially those in a
production environment from which a direct connection to My Oracle Support for
downloading patches is not appropriate or possible.

1.5.4 Support for Patching Machines That Cannot Connect to My Oracle Support
Smart Update does not require each machine being updated to connect directly to My
Oracle Support or to the internet. Smart Update can be used in GUI or command-line
mode to apply, remove, and view patches and patch information.
At least one Internet-connected machine is required for downloading patches from My
Oracle Support. These machines can be made available to offline machines within the
enterprise. On the offline machines, set the Smart Update download directory to the
directory to which you downloaded the patches.

1.5.4.1 Smart Update Client
The updated Smart Update client installers that apply the latest version are provided
free. For more information, see Section 1.3, "Downloading and Installing Smart Update
3.3.0."
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1.5.4.2 Patches and the Patch Catalog
On machines with internet access, when you download a new patch, the patch
contains a copy of the latest patch catalog, which reflects the current state of the Smart
Update repository. When you run Smart Update, it detects and uses the latest local
version of the patch catalog.
To obtain and apply patches to offline machines:
■

Log in to My Oracle Support on a machine with internet access, and download
patches to this machine. For detailed information about how to locate and
download WebLogic Server patches, enter the following document ID in the
Knowledge Base search field on My Oracle Support:
1302053.1

■
■

■

Unzip the patch ZIP file to a directory.
Copy the entire directory to which you extracted the patch ZIP file to a location
that can be accessed by the offline machines.
Run Smart Update and apply the patches that have been made available by other
means, such as e-mail, FTP, or physical media delivery.

1.5.5 Simplified Maintenance Rollback
Smart Update makes it easy to remove patches that have been applied, enabling you to
restore earlier maintenance levels accurately and reliably. For more information, see
Chapter 7, "Uninstalling Patches."
■

■

As part of its patch validation process, when you run Smart Update, it checks the
current local patch catalog, and notifies you if any currently installed patches are
obsolete. If the current patch catalog is outdated, however, you will not be notified
if My Oracle Support has since issued a patch that supersedes an earlier one that
you have applied to your installation. Oracle also recommends that you always
check My Oracle Support for replacement patches.
Based on the information in the current local patch catalog, if any patch in your
download directory that has been superseded or deprecated, Smart Update
highlights the entry for it in the list of applied patches, and marks it as invalidated.
Information about a replacement patch, if available, is added to the description of
the invalidated patch.

1.5.6 Scoping a Patch to Specific Applications, Domains, or Servers
To support complex production environments, Smart Update enables you to point an
individual WebLogic domain or server at a patch that is not automatically in effect
installation-wide; for example, a patch for the WebLogic system classpath that you
want to use only in a single test domain. Using this feature is recommended if you
have multiple products installed in a given Middleware home directory, and your
WebLogic domains are based on specific products.
For example, if you have a domain that is based on Oracle Service Bus, you should
scope any Oracle Service Bus classpath patches to only that domain. This way, servers
in other domains that do not use Oracle Service Bus do not run with Oracle Service
Bus classes in their classpath.
Similarly, you may also want to apply a patch to only selected applications and not all
applications for a given WebLogic domain.
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1.6 Resources Available from My Oracle Support
If you have a valid My Oracle Support login ID, you can view and download patches
by logging in to My Oracle Support directly.
For information about creating a My Oracle Support account, see Section 2.1, "Before
You Begin."

1.7 Overview of Applying Patches
Smart Update makes it easy to view and install maintenance patches for a target
product installation. Smart Update also helps you organize patches by providing a list
of the patches that you have downloaded and applied.
In the main Smart Update window you can view lists of downloaded and applied
patches on the Manage Patches tab. The Manage Patches tab displays two lists of
patches. These include a list of patches applied to the target product installation and a
list of patches that have been downloaded for the target installation and are ready to
be applied.
The process of applying patches consists of the following steps:
1.

From a web browser, log into My Oracle Support.

2.

Locate and download the SU patches you want to apply to your product
installation.

3.

Extract the contents of each downloaded ZIP file into the Smart Update download
directory.

4.

Run the Smart Update tool.

5.

Select the product installation to which you want to apply patches.

6.

Apply the patches

7.

Resolve any validation conflicts.

For information about how to locate and download SU patches using My Oracle
Support, see Chapter 2, "Downloading Patches."
For information about using Smart Update to apply patches, see Chapter 4, "Applying
Patches."

1.7.1 Providing Maintenance to Distributed Machines
The command-line interface to Smart Update is especially convenient for maintaining
large numbers of distributed machines in a carefully controlled, reliable, and
reproducible state. For example, suppose you are involved in the following business
scenarios:
■

■

You have a tightly controlled production environment in which you must run
multiple installations of products at highly specific maintenance levels.
The business practices for your IT environment require that software maintenance
updates are distributed to all machines from a central, internal source.

The following steps provide an example of using Smart Update command-line
interface to apply a specific set of patches to multiple machines:
1.

From a machine with internet access, log in to My Oracle Support to download the
required patches.
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2.

Copy the patches and an updated patch catalog into a location that can be
accessed by each machine to which the patches are to be applied.

3.

Create a shell script that contains the Smart Update commands for applying those
patches.

4.

Run the script on each machine on which the products are installed.
The machine to which you download patches from My Oracle
Support must have a target installation selected that matches the
distributed target installations to be updated.

Note:

For an example of distributing patches to multiple product installations in a
production environment, see Chapter 9, "Best Practices for Distributing Patches."

1.7.2 Maintaining Machines That Do Not Have Access to My Oracle Support
Under some circumstances, it is not desirable or possible to establish a direct
connection from a particular machine to My Oracle Support. For example:
■

■

You urgently need to download and apply a critical patch, but the internet
connection for your business is temporarily unavailable due to a system failure.
You need to provide regularly scheduled maintenance updates to production
machines that reside in a DMZ, or behind a firewall, where connecting to My
Oracle Support is permanently disabled.

Smart Update supports a variety of methods for providing patches to such machines.
Smart Update enables you to obtain patches from sources such as remotely mounted
disks or removable media. By taking advantage of this flexibility, you can adapt Smart
Update to your organization’s IT practices and create a controlled, reliable, and
reproducible process for maintaining your product installations.
If your environment includes at least one machine from which you can log in to My
Oracle Support, you can obtain and distribute patches to all product installations in
your environment that are supported by Smart Update. Download the patches to the
Smart Update download directory on the machine with internet access. The default
download directory is MW_HOME\utils\bsu\cache_dir\.
For information on downloading patches, see Chapter 2, "Downloading Patches."
For information on applying patches, see the following chapters:
■

■

If using the GUI in offline mode, see Section 3, "Starting Smart Update," and
Section 4, "Applying Patches."
If using the command line, Chapter 8, "Using the Command-Line Interface."

1.7.2.1 Patching New Versions of Smart Update Manually
You can view the version number of the Smart Update installation by choosing Help >
About from the GUI or by using the -version option in command-line mode. When
you update Smart Update on a machine that can connect to My Oracle Support, you
must also update all other machines on which you use Smart Update. All machines
must have the same version of Smart Update installed.
If an incompatible version of Smart Update is used to apply a patch, there can be
errors. These errors usually do not indicate that the cause is mismatched Smart Update
versions. In such cases, My Oracle Support can confirm that there is a mismatch and
supply a standalone Smart Update installer. The mismatch can be ascertained from the
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log files; see Section 8.1, "About the bsu Command," for information on the -log
option.
You can use the standalone installer that is available from My Oracle Support to install
either to an empty MW_HOME or to an existing MW_HOME containing installed products.
See Section 1.3, "Downloading and Installing Smart Update 3.3.0," for information on
how to obtain Smart Update 3.3.0. When it is installed in an existing MW_HOME, the
installer creates the necessary directories and replaces any existing version of Smart
Update.
The standalone installer does not touch the contents of the existing cache_dir
directory, and should not affect any of the previously applied patches. It also does not
replace an existing patch-catalog.xml file.
1.7.2.1.1 Ensuring Smart Update Matches the Latest Version Used on the Connected Machine
To ensure that you have the latest version of all the required files, copy all the patches
and all patch-*.xml files in the download directory, including the
patch-catalog.xml from the connected machine to the offline machine.
The default patch download directory is MW_HOME\utils\bsu\cache_dir. This can
be changed from the Preference menu or by using the parameter patch_download_
dir in command-line mode.
The encoded patch catalog, patch-catalog.xml, contains metadata about a patch
and the patch dependencies and conflicts.
In a complete offline environment, contact My Oracle Support to obtain the latest copy
of the patches and patch catalogs.
Figure 1–1 illustrates an example of providing patches to machines that are not
connected directly to My Oracle Support.
Figure 1–1 Example of Patching a Machine that is not Connected to My Oracle Support

For more information, see Section 9.2, "Providing Patches to Systems that Cannot
Connect to My Oracle Support."
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As of Smart Update 3.3.0, you can no longer use Smart Update to download patches.
You must instead log in to My Oracle Support directly to download the appropriate
patches. This chapter describes how to do this.

2.1 Before You Begin
Prior to downloading patches from My Oracle Support:
■

■

■

Have a valid My Oracle Support login and password available. If you do not have
a My Oracle Support account, go to https://support.oracle.com, click the
Register link, and follow the instructions.
Determine the directory to which you want to download patches. If all machines
have internet access, you should download patches to the same directory path on
each machine (although this is not required). If you have machines that do not
have internet access, download patches to a centralized location, such as a
remotely mounted disk or removable media.
Make a note of the version number of your current product installation. You will
need this information when searching for available patches on My Oracle Support.

2.2 Downloading Patches From My Oracle Support
This section describes how to download patches from My Oracle Support. For
additional information, enter document ID 1302053.1 in the Knowledge Base search
field on My Oracle Support.
To download patches from My Oracle Support:
1.

Open a web browser and enter the following URL:
https://support.oracle.com/CSP/ui/flash.html

2.

Click the Sign In button and log in using your My Oracle Support login name and
password.

3.

Click the Patches and Updates tab. From this tab, you have two options for
downloading patches:
■

■

Enter the patch number and platform to download a single patch. See
Section 2.2.1, "Downloading a Single Patch Using the Oracle Patch Number."
Search for all available patches for your current product installation. See
Section 2.2.3, "Searching for and Downloading All Available Patches."
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As of Smart Update 3.3.0, you can download and apply only
those patches for which the description starts with SU Patch.

Note:

2.2.1 Downloading a Single Patch Using the Oracle Patch Number
If you know the Oracle patch number for the patch you want to download:
1.

In the Patch Search section, click the Patch Name, Number, or Sun CR ID link.

2.

Select the appropriate entries for the following fields:
■
■

Patch Name or Number—Enter the patch number.
Platform—Select up to five platforms for the specified patch number. You can
also change to another search criteria. For example, to find the patch for your
language, change Platform to Language and then enter one or more
languages.

3.

Click Search. The Patch Search Results are displayed.

4.

Select the check box for the patch.

5.

Click Download.

6.

Click the patch file name, and then click Save.

7.

Select the download location and click Save.

8.

Click Close to close the dialog box.

2.2.2 Downloading a Single Patch Using the Smart Update Patch ID
If you know the Smart Update patch ID (for example, CX138) for the patch you want
to download:
1.

In the Patch Search section, click the Product or Family (Advanced Search) link.

2.

Select the appropriate entries for the following fields:
■

■

■

Product—Select one or more products from this drop-down list. To select
multiple products, press the Ctrl key while clicking on each product name.
Release—Select one or more release version numbers for the specified
product.
Platform—Change Platform to Description and then enter the Smart Update
patch ID as the search text.

3.

Click Search. The Patch Search Results are displayed.

4.

Select the check box for the patch.

5.

Click Download.

6.

Click the patch file name, and then click Save.

7.

Select the download location and click Save.

8.

Click Close to close the dialog box.

2.2.3 Searching for and Downloading All Available Patches
If you want to search for all available patches for your production installation, and
download one or more of those patches:
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1.

In the Patch Search section, click the Product or Family (Advanced Search) link.

2.

Select the appropriate entries for the following fields:
■

■

■

Product—Select one or more products from this drop-down list. To select
multiple products, press the Ctrl key while clicking on each product name.
Release—Select one or more release version numbers for the specified
product.
Platform—Select up to five platforms for the selected product. You can also
change to another search criteria. For example, to find all bugs that contain SU
Patch in the description, change Platform to Description and then enter SU
Patch as the search text.

3.

Click Search. The Patch Search Results are displayed.

4.

Select the check box for each patch that you want to download.

5.

Click Download. A dialog box appears listing all of the patches that you selected.

6.

For each patch in the list, click the patch file name, and then click Save.

7.

Select the download location and click Save.

8.

When done downloading all patches, click Close on the dialog box.
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This section provides the following topics:
■

Section 3.1, "Before You Begin"

■

Section 3.2, "How to Start Smart Update"

■

Section 3.3, "Setting Preferences"

3.1 Before You Begin
Before you start Smart Update to apply updates to your product installations, read the
following sections:
■

Section 3.1.1, "Unzipping Downloaded Patches"

■

Section 3.1.2, "Obtaining Required Access"

3.1.1 Unzipping Downloaded Patches
All SU Patch files that you download from My Oracle Support are compressed ZIP
files. Before you run Smart Update to apply the patches, you must decompress these
ZIP files using the appropriate tool for your environment (such as 7-Zip or WinZip for
Windows, or tar or gunzip for Linux).
When you unzip each file, the patch JAR file and a README.txt file are extracted.
When extracting the files, note that you must extract the files into the directory from
which you intend to apply the patches. This is the location that you set as the Patch
Download Directory of Smart Update, as described in Section 3.3, "Setting
Preferences." Alternatively, you can extract the files to a subdirectory, and then move
the patch JAR file to the patch download directory.

3.1.2 Obtaining Required Access
Before you start Smart Update, ensure that you have access to all required resources.
Specifically:
■

■

Ensure that you have proper write privileges for the patch download directory,
particularly if this directory resides on a remote disk drive or computer.
Ensure that you have the privileges required to access the target product
installation directories. The ability to access these directories is especially
important if you are patching product installations on networked or remotely
mounted disk drives.
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3.2 How to Start Smart Update
Table 3–1 provides instructions for starting the Smart Update graphical interface on
Windows and UNIX systems.
Table 3–1

Starting Smart Update

To start Smart Update on this
platform

Perform the following steps

Windows

From the Start Menu, choose:
Start > Programs > Oracle WebLogic > Smart Update
Or, from an MS-DOS command prompt window:
1.

Go to the MW_HOME\utils\bsu directory, where MW_
HOME is the host directory for the product installation
that you want to update.

2.

At the prompt, enter the following command:
bsu.cmd
The Smart Update main window is displayed.

UNIX

1.

Log in to the UNIX system.

Note: If you want to run Smart
Update on a UNIX system, the
console attached to the system
on which you are upgrading the
software must support a
Java-based GUI.

2.

Go to the MW_HOME/utils/bsu directory, where MW_
HOME is the host directory for the product installation
that you want to update.

3.

At the prompt, enter the following command:
bsu.sh
The Smart Update main window is displayed.

After starting Smart Update for the first time, set the Patch Download Directory to the
appropriate location; see Section 3.3.1, "Choosing a Patch Download Directory."

3.3 Setting Preferences
From the Preferences dialog box, you can set the following options:
■
■

■

Location of the patch download directory
Display mode for patch sets in the Downloaded Patches panel of the Smart
Update window
HTTP proxy or perimeter security authentication information. This applies only to
the Smart Update client self-update mechanism.

3.3.1 Choosing a Patch Download Directory
Before you apply patches that you have downloaded from My Oracle Support, Oracle
recommends that you choose an appropriate location to serve as the patch download
directory. Store all downloaded patches in this directory.
The patch download directory is a single-level directory or folder that Smart Update
uses to determine which patches are available to be applied. Before you start applying
patches, ensure that you have designated a directory to serve this function, as
described in this section.
A patch download directory is created automatically when you upgrade to Smart
Update 3.3.0, but you may not want to use it in its default location. For example, your
organization might encourage or require you to use a particular location for storing
patches that are downloaded from software vendors. This location might be a
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centralized repository, or a set of cache directories labeled for certain configurations.
By taking advantage of the flexibility of Smart Update for storing updates, you can
adapt Smart Update to business practices in which software maintenance is
administered centrally or in which the maintenance image must be replicated easily
for promotion to QA, staging, and production environments.
To designate a patch download directory, complete the following steps:
1.

Start Smart Update.

2.

From the main Smart Update window, choose File > Preferences.
The Preferences dialog box is displayed.

3.

In the Patch Download Directory section of the Preferences dialog box, specify
the path of the patch download directory.
Note the following information about the patch download directory:
–

The directory MW_HOME\utils\bsu\cache_dir is created as the default
patch download directory when you install Smart Update 3.3.0.

–

Until you specify a different directory, the default patch download directory is
used for storing downloaded patches for all products on your system; the
directory used for this purpose is not changed when additional Middleware
home directories are created.

–

If you have multiple Middleware home directories, Oracle recommends that
you change the Patch Download Directory to point to the MW_
HOME\utils\bsu\cache_dir for the installation target to which the
patches apply. By doing so, the patches will be available if you need to apply
them when running Smart Update from the Middleware home for the target
installation.

3.3.2 Displaying Patch Sets in the Downloaded Patches Panel
Smart Update lets you select a display mode for Smart Update patch sets shown in the
Downloaded Patches panel of the main Smart Update window. Smart Update patch
sets are a group of patches that are bundled into a single patch. These should not be
confused with Oracle Patch Set releases (version upgrades) for WebLogic Server,
which can only be installed using an Upgrade installer.
■

■

Choose Display patch sets and all constituent patches if you want to display an
entry for each patch in a patch set you have installed, and an entry for the patch
set itself. (This is the default setting.)
Choose Hide constituent patches when patch set is present and complete if you
want to display only the entry for the patch set that you have installed, hiding
entries for individual patches that belong to the set.

3.3.3 Setting HTTP Proxy Information
If the system on which you are running Smart Update is located behind a firewall, you
might need to specify one of the following options so that you can download patches.
These settings apply only to the Smart Update client self-update mechanism. Smart
Update can check to see if an updated version of the Smart Update client is available,
and if so, prompts you to download it. Smart Update then updates itself to the new
version.
■

Use HTTP Proxy
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Select this option if you want to use an HTTP Proxy server for the download. To
use an HTTP Proxy server, you must specify the following settings in Smart
Update, before logging into the download server for the first time. Subsequently
you do not need to change the settings.
In the Login dialog box, click Work Offline, and specify the following:

■

–

Host—The name or IP address of the proxy server

–

Port—The port number of the proxy server

Use Authentication
Select this option if the HTTP Proxy server you are using requires server-side
authentication. If you select this option, you must specify:
–

Username—A valid username required by the proxy server

–

Password—A valid password for the user
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This chapter describes how to apply the patches that you have downloaded from My
Oracle Support and stored in the patch download directory.
This section includes the following topics:
■

Section 4.1, "Choosing a Target Installation"

■

Section 4.2, "Viewing Patch Information"

■

Section 4.3, "Applying and Managing Patches"

■

Section 4.4, "Resolving Patch Conflicts"

■

Section 4.5, "Creating and Using Maintenance Snapshots"

■

Section 4.6, "Applying a Patch to the Client"

4.1 Choosing a Target Installation
Smart Update displays a Target Installation panel, shown in Figure 4–1, that shows all
of the WebLogic product installations that were detected on the system on which you
started Smart Update. In this example, WebLogic Platform 10.3 MP2 (that is, 10.3.2) is
the currently selected target installation.
Figure 4–1 Target Installation Panel

The subsequent operations you can perform with Smart Update are specific to the
installation you have selected as the target installation. For example:
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■

■

The set of patches that are listed in the Downloaded Patches panel are specific to
the selected target installation. Smart Update prevents you from applying a patch
created for a product other than the one that is currently selected as the target
installation.
Patch validation, which is the built-in ability of Smart Update to use the validation
data provided by My Oracle Support to eliminate the chances of applying a patch
with a known conflict, is specific to the selected target installation.

Patches that you apply to one target installation are not applied to any other
installation listed in this panel. For example, if you have duplicate installations of one
product, either in the same Middleware home directory or in a different Middleware
home directory, you can apply patches to only one of those installations at a time. Note
that having multiple Middleware home directories on a system is generally not
recommended.
When selecting a target installation, keep the following information in mind:
■

The set of Middleware home directories displayed in this panel is not restricted to
those detected on the current system. If you have used the current system to install
products on remotely mounted disks hosted on other systems, the Middleware
home directories for those remote products are displayed as well. This complete
listing makes it easy to install maintenance updates on remote systems.
The Smart Update graphical interface does not detect
Middleware home directories created by systems other than the one
from which you are running Smart Update.

Note:

■

■

■

■

You can install patches on only one target installation at a time; patches cannot be
installed on multiple installations in a single step. You can, however, install
patches to multiple target installations in a single Smart Update session. After
installing patches on one target installation, you do not have to restart Smart
Update before installing patches to another target installation.
The most recently selected target installation is saved when you exit Smart
Update, and is highlighted the next time you start Smart Update. When a single
Middleware home directory hosts multiple product installations, you may update
those installations in any sequence you like.
The list of product installations in a Middleware home directory can be expanded
or collapsed, as preferred. By default, it is expanded.
If you are using the Smart Update command-line interface, be sure to include the
-prod_dir=path parameter to set the target installation directory when you
start Smart Update. See Chapter 8, "Using the Command-Line Interface."

4.1.1 Specifying Other Middleware Home Directories
You can also specify other Middleware home directories that are not listed in the
Target Installation panel.
The Middleware home can only be a directory on a local drive,
or a locally mounted volume.

Note:

If there is no valid installation target when you start Smart Update, a dialog box is
displayed in which you must specify a Middleware home before proceeding.

4-2 Smart Update Applying Patches to Oracle WebLogic Server

Viewing Patch Information

To specify the Middleware home directory:
1.

Choose File > Target Installation > Find Other BEA Home

2.

Specify a valid Middleware home directory navigate the hierarchy and select a
directory, or type the path in the Location field.

3.

Click OK. The new directory is added to the Target Installation panel.

If the directory you specified does not include a valid installation target, an error
message is displayed.

4.2 Viewing Patch Information
Smart Update offers you the option of reading detailed information about a patch
before applying it. Specifically, Smart Update provides this option for patches in two
categories. These categories are those that are publicly available for download from
My Oracle Support and those that have been downloaded by you, either to your
system or to a networked disk drive that you can access.
To obtain a list of patches that are publicly available for
download, you must be logged in to My Oracle Support.

Note:

4.2.1 How to Display Patches
The Manage Patches tab lists all patches that are currently residing in the patch
download directory.
■

■

Patches that have been applied to the target installation through the currently
selected patch profile are listed in the top panel. Patch profiles are described in
Section 4.3.1, "About Patch Profiles."
Patches that have not been applied to the target installation within the context of
the currently selected patch profile are listed in the Downloaded Patches panel.

For an explanation of the information displayed in the Downloaded Patches panel,
see Section 4.2.3, "Viewing Currently Downloaded Patches."
You can also view lists of patches that have been downloaded into a directory other
than the current patch download directory by specifying the desired directory in the
Preferences dialog box. For more information, see Section 3.3.1, "Choosing a Patch
Download Directory."

4.2.2 About Patches Displayed in the Manage Patches Tab
Table 4–1 describes the information displayed in each column of the top and bottom
panel of the Manage Patches tab. Some columns are not available in each panel.
Table 4–1

Information about Patches Available for Download

Column Title

Description

Patch ID

The patch identifier is a unique string that is associated with a patch. The
following information icon is displayed beside the patch identifier:

Bug

The Oracle bug number that is associated with the patch identifier.

Description

A brief description of the patch.
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Table 4–1 (Cont.) Information about Patches Available for Download
Column Title

Description

Product

The name of the product to which the patch applies, such as WebLogic
Server, Workshop for WebLogic, WebLogic Portal, JRockit, or Oracle Service
Bus.

Category

The product category to which the patch applies. For example:
■

JMS—A patch for WebLogic Java Message Service

■

Security—A patch for the WebLogic Security Service

■

Console—A patch for the WebLogic Administration Console

Remove

To remove an installed patch, click the icon in the Remove column.

Apply

To apply a downloaded patch, click the icon in the Apply column.

4.2.3 Viewing Currently Downloaded Patches
The Manage Patches tab displays a list of the patches that are available in the current
patch download directory for the currently selected target installation. It contains the
following panels:
■

A patch profile panel—Displays a list of the patches that have already been
applied to the current target installation. The Default patch profile, which lists the
patches that have been applied to the entire target installation, is described in
Section 4.3.1, "About Patch Profiles." This panel also contains one additional tab
for each custom profile you created.
Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

Note:

■

Downloaded Patches—Displays a list of the patches that currently reside in the
patch download directory but have not yet been applied to the current target
installation for the currently selected patch profile. After you apply a patch to the
target installation, the entry for that patch is removed from the list in the
downloaded patch panel of the Manage Patches tab for the appropriate patch
profile. For more information, see Section 4.3.2, "Applying a Patch to the Target
Installation."

If you designate a different directory as the patch download directory, the list of
patches shown in the Downloaded Patches panel updates accordingly. If patches have
been downloaded to multiple locations in your system environment, and those
locations are accessible through networked disk drives, you can access those patches
simply by designating a new patch download directory. For more information about
designating a different patch download directory, see Section 3.3.1, "Choosing a Patch
Download Directory."

4.2.4 Viewing Details About a Patch
For detailed information about a patch, click the information icon beside the
appropriate patch identifier. A Patch Details dialog box, similar to what is shown in
Figure 4–2, "Patch Details Dialog Box", is displayed.
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Figure 4–2 Patch Details Dialog Box

Smart Update displays a dialog box with the details defined in Table 4–2.
Table 4–2

Key to Patch Details

This detail

Specifies

Product

The product to which the patch applies.

Version

The version of the product for which the patch is intended.

Severity

Whether the patch is critical or optional.

Category

The product category to which the patch applies.

Restart

The software component that must be restarted after the patch is applied.

Size (KB)

Identifies the size, in kilobytes, of the patch.

Status

Availability of the patch. All patches that you download from My Oracle
Support have a status of Public.

OS

The operating system on which the patch is designed to run.

Description

A brief description of the issued that the patch resolves.

When done viewing the patch details, click OK to close the Patch Details dialog box
and return to the main Smart Update window.

4.3 Applying and Managing Patches
After you download patches into the patch download directory, you can apply them to
a target installation. The following sections explain how to apply and manage patches:
■

Section 4.3.1, "About Patch Profiles"

■

Section 4.3.2, "Applying a Patch to the Target Installation"

■

Section 4.3.3, "Removing a Patch From the Target Installation"

4.3.1 About Patch Profiles
Smart Update uses the notion of a patch profile to help manage sets of patches. A patch
profile contains a list of patches that have been applied. Every target installation has a
default patch profile defined. Patches listed in the default patch profile are in effect
installation-wide, and are also in effect, by default, for all applications, WebLogic
domains, and WebLogic Server instances that run from that installation.
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To meet typical maintenance requirements, the default patch profile is the only profile
that most users need to work with. The default patch profile is available out-of-the-box
and does not need to be configured.
You may also choose to create custom patch profiles. Custom patch profiles enable you
to associate specific servers, domains, or applications in an installation with a set of
one or more patches that are not intended to be in effect installation-wide. However,
the use of custom patch profiles raises the level of complexity of maintaining your
product installations. Custom patch profiles are described in Chapter 6, "Patching
Individual Applications, Domains, or Servers."

Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

Note:

4.3.2 Applying a Patch to the Target Installation
To apply a patch to the target installation, click the Apply icon next to that patch in the
Downloaded Patches panel.

Note:

To avoid unexpected errors, stop the server when applying a

patch.
When you apply a patch to the target installation, the following events occur:
1.

The patch is validated against patches in the current patch profile.

Note: If you have multiple patch profiles for the target installation,
and you apply a patch that affects installation-wide resources, Smart
Update displays a warning popup to alert you. Examples of patches
that are in effect for an entire installation include those that replace
system resources, or that address a security advisory. If you choose to
proceed, Smart Update automatically applies the patch to all patch
profiles defined in the target installation.
2.

If there are no patch conflicts, the patch is applied.
If there are conflicts, the Patch Installation Validation dialog box is displayed,
summarizing conflicts. The patch is not applied.

3.

If the patch is applied, the patch is added to the current patch profile. The patch is
no longer listed in the Downloaded Patches panel of the Manage Patches tab for
this profile.

If conflicts are detected during validation, you must resolve those conflicts before you
can apply the patch. For more information, see Section 4.4, "Resolving Patch Conflicts."
For certain patch types, the applied maintenance may not get activated automatically
in the user applications and WebLogic domains. Depending on the patch type,
regardless of whether it was applied to the default profile or a custom profile, and the
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system environment and configuration, administrators may need to do one or more of
the following:
■

Start or restart a server

■

Start or restart an application

■

Undeploy/deploy an application

■

Edit a WebLogic domain or server start script

■

Deploy a library module to an application

■

Edit a domain configuration file

■

Edit an application descriptors file

4.3.3 Removing a Patch From the Target Installation
If you have applied a patch that you need to remove from the target installation—for
example, the patch does not correct the problem as expected, the patch is not needed,
or the patch creates new problems and you are awaiting a replacement patch from My
Oracle Support—click the Remove icon next to the listing of that patch in the
corresponding patch profile.

Note:

To avoid unexpected errors, stop the server when removing a

patch.
When you remove a patch from the target installation, the following events occur:
1.

The removal operation is validated, similar to the validation that occurs when you
apply a patch. When you remove a patch from the target installation, Smart
Update checks the current patch profile to determine if any other patches depend
on the one you are removing.

2.

If a conflict is detected, Smart Update displays the Patch Removal Validation
dialog box and identifies the specific conflict. If you have a conflict, you must
resolve it before you can remove the patch.

3.

If no removal conflict is detected:
a.

The patch is removed from the target installation and from the current patch
profile.

b.

The patch is added to the list displayed in the Downloaded Patches panel, in
the Manage Patches tab, under the current patch profile list.

When removing patches, note that:
■

■

■

If you have multiple patch profiles for the target installation and you remove a
patch that affects installation-wide resources, Smart Update displays a warning
popup to alert you. If you choose to proceed, Smart Update automatically removes
the patch from all patch profiles defined in the target installation.
If you remove a patch that is not installation-wide, that patch is removed from the
current patch profile.
After removing a patch that affects the run-time behavior of server instances in the
product installation, restart the servers for the patch removal to take effect.

Applying Patches

4-7

Resolving Patch Conflicts

For information about correcting removal conflicts, see Section 4.4, "Resolving Patch
Conflicts."

4.4 Resolving Patch Conflicts
Smart Update protects your system by validating the compatibility of any patch that
you want to apply or remove with the other patches that have been applied to the
target installation. Any validation problem that occurs is reported as a patch conflict,
which you can resolve before completing the patch operation.
This section describes the types of conflicts that may be identified during the following
validation processes:
■

Section 4.4.1, "Validation When Applying Patches"

■

Section 4.4.2, "Validation When Removing Patches"

Each section also provides instructions for resolving each type of conflict.

4.4.1 Validation When Applying Patches
During the process of applying a patch, various conflicts may be reported. Once a
conflict has been reported, it must be resolved before you can apply the patch.
Table 4–3 describes the types of conflicts that may be reported when a patch is being
validated when you attempt to apply it, and it provides procedures for correcting each
type.
Table 4–3

Conflict Conditions When Applying a Patch

If this conflict is
reported

The patch you have
selected to apply

To resolve this conflict and apply the
selected patch

Prerequisite not met

Cannot be applied until
you apply one or more
other patches

1.

Note the identifiers of the prerequisite
patches.

2.

Click Cancel to terminate the process
of applying the selected patch.

3.

Download and apply the prerequisite
patches identified in step 1.

4.

Apply the patch you originally
selected.

1.

Note the identifiers of the patches that
must be removed.

2.

Click Cancel to terminate the process
of applying the selected patch.

3.

Remove the patches identified in step
1.

4.

Apply the patch you originally
selected.

5.

Re-apply the patches removed in step
3.

Out of sequence

Mutually exclusive

Cannot be applied until
you remove one or more
patches that you applied
earlier

Cannot coexist with one Choose the patch that you want applied to
or more patches that you the target installation and, if necessary,
applied earlier
apply it.
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4.4.2 Validation When Removing Patches
Table 4–4 describes the conflict that may be identified when you attempt to remove a
patch, and a procedure for resolving that conflict.
Table 4–4

Conflict Condition When Removing a Patch

If this conflict is
reported

The patch you have
selected for removal

To resolve this conflict and remove the
selected patch

dependency
violated

Is required by one or
1.
more patches that have
been applied

Note the identifiers of the dependent
patches.

2.

Click Cancel to terminate the download
process.

3.

As appropriate, remove the dependent
patches.

4.

Remove the patch that you originally
selected for removal.

4.5 Creating and Using Maintenance Snapshots
To make it easy for you to provide the information needed by My Oracle Support to
help you resolve problems, Smart Update provides a way to capture information
about the patches that have been applied to a specific patch profile. This is called a
maintenance snapshot, a plain ASCII file that contains information about the patch
profile selected in the Manage Patches tab, including the identity of each patch that
has been applied to that profile.
If you report a problem, My Oracle Support requests this snapshot as the first step in
providing you with a solution. Therefore, if you experience a problem, Oracle strongly
recommends that you prepare a maintenance snapshot before contacting Customer
Support.
It takes only a moment to create a maintenance snapshot, using the Smart Update
graphical interface:
1.

In the Target Installation panel in the main Smart Update window, select the
product installation for a problem that is being reported.

2.

From the Manage Patches tab, select the patch profile with which you are
reporting a problem.

3.

Choose Patches > Patch Profiles > Save Snapshot
A dialog box prompts you to specify the name and location of the maintenance
snapshot. By default, the maintenance snapshot file is created in MW_
HOME\utils\bsu. If you specify a different location, ensure that you have the
privileges required to access a file there.

You can also use the Smart Update command-line interface to create a maintenance
snapshot. For an example, see Section 8.3, "Command-Line Interface Examples."
Oracle recommends that you observe the following practices whenever you create a
maintenance snapshot:
■

■

Save all maintenance snapshots for a particular product installation in a place
where you can find them easily.
Use a file name for the maintenance snapshot that helps you distinguish among
other snapshots. For example, indicate the patch profile name, such as
MyCustomProfile.txt.
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Whenever you send a maintenance snapshot to My Oracle Support, keep a log of your
support-related activities.

4.6 Applying a Patch to the Client
WebLogic Server patches can be applied to the server, client, or both. This section
describes what you must do to apply the patch to the client.
1.

Download the patch as described in Chapter 2, "Downloading Patches."

2.

Extract the patch JAR file as described in Chapter 3.1.1, "Unzipping Downloaded
Patches."

3.

Copy the class files that are in the patch JAR file to the appropriate directory, or
reference the class JAR in the JMS client environment by placing the path of the
directory in which it is located at the beginning of the classpath.
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Activating Applied Patches in Your
Installations and Applications
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This section includes the following topics:
■

Section 5.1, "Overview"

■

Section 5.2, "Classpath, Extended Classpath, and Native Library Patches"

■

Section 5.3, "Modifying a Start Script"

■

Section 5.4, "Using the Start Script Editor"

■

Section 5.5, "Pointing All Domains and Servers at Patches Through Custom
Scripts"

■

Section 5.6, "Module Patching"

■

Section 5.7, "Native Binaries and Other Artifacts Patches"

■

Section 5.8, "Shared Archive Patches"

5.1 Overview
After you apply patches that contain classes to be loaded into a classpath, such as the
WebLogic system classpath or the classpath of an application deployed on WebLogic
Server, you must ensure that those classes are properly inserted into the appropriate
classpath; otherwise they do not take effect. Likewise, if a patch contains library files to
be inserted into the library path, you must ensure that the paths for those files are
properly handled when the server instances or applications by which they are used are
started.
Smart Update does not use a single method to apply all patches to a product
installation; the method used depends on the type of patch and its contents. Patches
may contain any of the following:
■
■

■

Replacements for resources within a product installation
Class files that can be used by a classloading mechanism, such as a classpath and
files in an extension directory
Library files that can be included in a library path
Patches that contain library files may not necessarily replace existing files in the
target installation. Therefore they must be loaded explicitly by a start script.

■

Shared archives that must be deployed and referenced by applications

■

Patch JAR files that update entities referred to as modules
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Review the following sections to learn how patches are applied and how Smart
Update organizes those patches on your system. Understanding these processes is
necessary to determine whether and how your start scripts should be modified:
■
■

Section 5.1.1, "Patches That Must Be Referenced By Start Scripts"
Section 5.1.2, "Patches That Replace Resources For All Applications, Domains, and
Servers"

■

Section 5.1.3, "Patches That Must Be Deployed and Referenced By Applications"

■

Section 5.1.4, "How Patch Files Are Stored on Your System By Smart Update"

■

Section 5.1.5, "Structure of the Installation-Level Patch Directories"

This section also introduces the basic tasks that you must perform to ensure that the
patches you apply to your WebLogic domains become effective:
■
■

■

Section 5.1.1, "Patches That Must Be Referenced By Start Scripts"
Section 5.1.2, "Patches That Replace Resources For All Applications, Domains, and
Servers"
Section 5.1.3, "Patches That Must Be Deployed and Referenced By Applications"

5.1.1 Patches That Must Be Referenced By Start Scripts
If a patch contains class or library files that are loaded by a start script, those classes or
files are stored, by Smart Update, in a central, installation-level patch directory on the
system. These classes and library files are then available for loading when the
WebLogic Server instances by which they are used are started.
Examples of patches in this category are those that contain
■
■

■

Class files that are loaded into the WebLogic Server system classpath
Class files that are loaded into the classpath of an application that is deployed on
WebLogic Server
Library files that are loaded into the library path for WebLogic Server.
Although a patch may be validated and applied to a target
installation at any time, some patches do not become effective
immediately. Any patch that contains either (a) classes to be loaded
into a classpath, or (b) native library files to be loaded into a library
path, does not become effective until you (a) modify the appropriate
WebLogic domain or server start scripts, if necessary, so that they
point to the patch and (b) restart the corresponding domains or
servers.

Note:

5.1.2 Patches That Replace Resources For All Applications, Domains, and Servers
Patches that replace existing resources in a product installation become effective,
automatically, throughout the installation, as soon as they are applied; they are not
enabled by a start script. Therefore, you do not need to change start scripts for patches
that contain replacements for system resources.
Examples of patches that typically contain replacement artifacts include the following:
■

Resources for Web server plug-ins

■

Socket multiplexers
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■

Dynamically linked libraries
Smart Update stores files that have been replaced in the
backup subdirectory of the installation-level patch directory. If you
subsequently remove the patch in which a replacement was delivered,
the original resource is restored from backup. (For details about
backup, see Table 5–1.) For optimal security, however, Oracle
recommends that you create a backup of any system resource that you
plan to replace before applying the patch that replaces it.
Note:

5.1.3 Patches That Must Be Deployed and Referenced By Applications
Shared archive patches must be explicitly deployed and referenced by applications
that require them. If a Shared Archive patch is to be applied to selected applications
and not all applications, you must create a custom patch profile for each unique patch
level.

5.1.4 How Patch Files Are Stored on Your System By Smart Update
When you download a patch from My Oracle Support, a patch container is placed in the
patch download directory. A patch container holds the following:
■

A patch
A patch may contain several files. These files may include

■

–

Classes delivered as replacements for classes, with the same name, that are
inserted into the WebLogic system classpath at server start time

–

Native library files to be inserted into the system path

–

Configuration files.

Metadata about each patch in the patch container
Metadata is information used by Smart Update to validate each patch against all
other patches applied to the same product installation. (When you apply a patch,
metadata is placed in a patch registry in a directory on your system that is
maintained by Smart Update. For details, see Section 5.1.5, "Structure of the
Installation-Level Patch Directories.")

When you apply a patch to a given patch profile, each file in the patch is handled as
follows:
■

■

If the patch contains a replacement for a system resource, such as a WebLogic
Server plug-in module, the existing resource is automatically updated with the
replacement.
If the patch contains a patch JAR file, that is, a set of classes to be loaded into a
classpath as updates for existing classes with the same names in the target
installation, the following events occur:
–

The patch JAR file is placed in the installation-level patch directory. For a
description of this directory, see Section 5.1.5, "Structure of the
Installation-Level Patch Directories."

–

Smart Update creates a file, called the patch manifest JAR, which contains
pointers to the classes in the patch JAR file. If a patch manifest JAR for the
current profile exists, it is updated with pointers to the classes in the patch JAR
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file. The patch manifest JAR file is described in Section 5.1.5.1, "Patch Manifest
JAR Files."
■

If the patch contains native library files to be loaded into the system library path,
through either the PATH or LIBPATH environment variable, Smart Update verifies
the existence of a subdirectory called native that is specific to the currently
selected patch profile. If Smart Update does not find such a subdirectory, it creates
one. For a description of the native subdirectory, see Section 5–5, " Open Start
Script Dialog Box Icons."

5.1.5 Structure of the Installation-Level Patch Directories
After you install the products and run Smart Update, the patch directories are created.
Each product (for example, WebLogic Server, Workshop for WebLogic, WebLogic
Integration, and WebLogic Portal) has its own patch directory structure (for example,
patch_wls1001, patch_wlw1020, patch_wli1020, and patch_wlp1020) under
the Middleware home directory.
Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

The product-specific patch directory structure provides clean demarcation of patch
maintenance on a product basis. It also provides more flexibility for future products to
interoperate with separate or common versions of WebLogic Server.
Figure 5–1 shows the structure of the MW_HOME\patch_product directories.
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Figure 5–1 Installation-Level Patch Directories

Table 5–1 describes the contents of each patch directory.
Table 5–1

Directories and Files in the Installation-Level Patch Directory

This directory

Contains

patch_product\backup

Contains the patch backup manifest, which includes files and
information required to restore an earlier patch level on your
system.
This directory is created when you apply an installation-wide
patch that contains files to be placed in the product installation
directory.
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Table 5–1 (Cont.) Directories and Files in the Installation-Level Patch Directory
This directory

Contains

patch_product\patch_jars

Patch JAR files, under each product patch directory (for
example, patch_wlp1020, patch_wls1001, and patch_
wlw1020 as shown in Figure 5–1), contain the class JAR files
from patches that have been applied to the product installation
on the system.
A patch JAR file under each product patch directory may
contain one or more of:
■

■

Classes intended as replacements for classes with the same
names in the installation. These classes must be inserted
into the WebLogic system classpath.
Classes required by a product. These classes must be
inserted into applications deployed on WebLogic Server.

Note: Patch JAR files containing replacements for system
resources are not stored in this directory (patch_jars).
Note: It is good practice to ensure that your system contains
enough disk space for the patch JAR files being added. For
information about the size of a patch containing a JAR file, see
Section 4.2, "Viewing Patch Information."
patch_
product\profiles\default

Directory for the default patch profile. When you apply a patch,
one or more of the following subdirectories may be created:
■

profiles\default\sys_manifest_classpath
Holds the patch manifest JAR file named weblogic_
patch.jar. This file contains references to classes in patch
JAR files (in the patch_jars directory) that are to be
inserted into the WebLogic system classpath. Patch manifest
JAR files are described in Section 5.1.5.1, "Patch Manifest
JAR Files."
Note: The majority of patches issued by My Oracle Support
are referenced by weblogic_patch.jar.

■

profiles\default\sysext_manifest_classpath
Holds the WebLogic extension directory patch manifest JAR
file named weblogic_ext_patch.jar. This file contains
references to classes in patch JAR files that are required by a
product and that must be inserted into the classpaths of
applications deployed on WebLogic Server based on that
product. Patch JAR files referenced by weblogic_ext_
patch.jar are also stored in the patch_jars directory.
Note: The sysext_manifest_classpath directory is not
used by WebLogic Server 9.1.

■

profiles\default\native
Holds native library files that are to be inserted into the
system library path and that supersede (not replace)
existing, same-named libraries in the installation. For
details, see Section 5.1.5.2, "Native Library Files."

■

profiles\default\modules
Holds module files that are used by Open Services Gateway
initiative (OSGi)-based products. The contents of this
directory are not used with WebLogic Server-based
products, which load modules through the classpath. For
details, see Section 5.1.5.3, "Module Patch Files."
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Table 5–1 (Cont.) Directories and Files in the Installation-Level Patch Directory
This directory

Contains

Directory for a custom patch profile. The directory takes the
patch_
product\profiles\custom-prof name of the custom patch profile. For every custom patch profile
created, a directory named for the profile is created
ile-name
automatically. Each custom patch profile directory may contain
one or more of the following subdirectories:
■

profiles\custom-profile-name\sys_manifest_
classpath
Holds the patch manifest JAR file, weblogic_patch.jar,
which contains references to classes in patch JAR files
inserted into the WebLogic system classpaths for server
instances that point to this custom patch profile.

■

profiles\custom-profile-name\sysext_
manifest_classpath
Holds the WebLogic extension directory patch manifest JAR
file, weblogic_ext_patch.jar, which contains
references to classes in patch JAR files in the patch_jars
directory that are inserted into the classpaths of applications
deployed on WebLogic Server instances that point to this
custom patch profile.
Note: The sysext_manifest_classpath directory is not
used by WebLogic Server 9.2.

■

profiles\custom-profile-name\native
Holds native library files that are to be inserted into the
system library path for server instances that point to this
custom patch profile.

■

profiles\custom-profile-name\modules
Holds module files that are used by OSGi-based products.

■

profiles\custom-profile-name\archives
Holds shared archive files that are to be deployed and
referenced by the applications that point to this custom
patch profile.

patch_product\registry

Contains information about
■

■

All patches that have been applied to the product
installation
Product installation files that have been replaced by
patches.

This information is used internally by Smart Update to perform
tasks such as patch validation.

5.1.5.1 Patch Manifest JAR Files
Patches that contain classes that supersede existing, same-named classes when they
are inserted into a classpath are referenced by a patch manifest JAR. When you apply a
patch that contains such classes to a patch profile, the patch manifest JAR file of that
profile is automatically updated by Smart Update to reference the classes in the patch.
For example, if a patch containing a JAR file called Bug10131320_1032.jar, which
contains WebLogic system-level classes, is applied to the default patch profile, Smart
Update performs the following tasks:
■

■

Adds Bug10131320_1032.jar to the MW_HOME\patch_wls1032\patch_
jars directory.
Creates the following file, if it does not exist already:
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MW_HOME\patch_wls1032\profiles\default\sys_manifest_classpath\weblogic_
patch.jar
■

In weblogic_patch.jar, adds the following reference to the WebLogic system
classes in Bug10131320_1032.jar:
Class-Path: C:\Oracle\Middleware\patch_wls1032\patch_jars\Bug10131320_1032.jar

■

Updates the patch registry information in the MW_HOME\patch_
wls1032\registry directory.

5.1.5.2 Native Library Files
If a patch contains native library files that are to be loaded into the system library path
when the corresponding WebLogic Server instance is started, those library files are
stored in the native subdirectory for the patch profile to which the patch has been
applied.
For example, if the patch contains the file libmuxer.so, which is to be loaded into
the system library path when the server is started, and the patch is applied to the
default patch profile, Smart Update does the following:
■

Creates the following directory, if it does not exist already:
MW_HOME\patch_wls1032\profiles\default\native

■

Puts libmuxer.so in the following directory:
MW_HOME\patch_wls1032\profiles\default\native

■

Updates the patch registry information maintained in the following directory:
MW_HOME\patch_wls1032\registry

5.1.5.3 Module Patch Files
When a module patch is applied, whether it is a common module patch or
product-specific module patch, Smart Update adds the patch to the MW_HOME\patch_
product\profiles\profileName\modules directory. The original module JAR
file is not modified. This approach is implemented to limit the scope of applied patch.
For example, if a module patch for WebLogic Event Server contains updated classes to
MW_HOME\wlevs20\modules\com.bea.wlevs.processor.monitor_
2.0.0.0.jar, and that patch is applied to the default patch profile, Smart Update
performs the following tasks:
1.

Creates the following directory, if it does not exist already:
MW_HOME\patch_wlevs20200\profiles\default\modules

2.

Adds the updated com.bea.wlevs.processor.monitor_2.0.0.0.jar in
the MW_HOME\patch_wlevs20200\profiles\default\modules directory

3.

Updates the patch registry information in the MW_HOME\patch_
wlevs20200\registry directory.

When WebLogic Event Server starts, it uses the patched module located in the MW_
HOME\patch_wlevs20200\profiles\default\modules instead of using the
original module that still exists in the MW_HOME\wlevs20200\modules directory.
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5.2 Classpath, Extended Classpath, and Native Library Patches
You can assume that your classpath and library path patches are picked up properly
when the WebLogic domain servers are started, without your having to modify any
start scripts, if:
■

■

Your WebLogic domains use the default scripts generated by the Configuration
Wizard for starting the Oracle product server instances configured for those
domains.
You do not need to limit the scope of a patch to a specific WebLogic domain or
server instance.

Under other conditions, however, you must take additional steps to ensure that
patches are inserted into the appropriate classpath or library path when the product
servers are started. These additional steps are necessary if the environment in which
you have applied patches to the products matches either of the following:
■

To start the servers in your WebLogic domains, you use custom scripts that do not
invoke the default commEnv script:
Windows:
WL_HOME\common\bin\commEnv.cmd

UNIX:
WL_HOME/common/bin/commEnv.sh
■

You need to limit the scope of a patch to a specific WebLogic domain or server,
instead of applying it universally to all domains and servers that run on a
particular product installation.

This section provides information on the use of scripts, and how to modify start scripts
using the Smart Update Start Script Editor. This section also describes custom scripts
that you can use to point all WebLogic domains and servers at patches of classpath,
extended classpath, and native library files.
Workshop for WebLogic (10.1 and later releases) does not
enable run-time WebLogic Server patches automatically. After
applying patches by using Smart Update, you must also specify the
patch profile for the run-time WebLogic Server in Workshop IDE. For
more information, see the Workshop for WebLogic documentation.

Note:

5.2.1 About Pointing Start Scripts at Patches
To ensure that a patch is loaded into a classpath or the system library path when a
WebLogic Server instance is started, you might need to add a pointer to the patch to
the start script for that server. The following sections explain how Smart Update works
and describe the changes that you might need to make to your start scripts:
■

■
■

■

Section 5.2.1.1, "Default Script that Defines Class and Library Paths for All
WebLogic Domains and Servers"
Section 5.2.1.2, "Default Patch Path Environment Variables"
Section 5.2.1.3, "How Patch Path Variables Are Inserted into Class and Library
Paths"
Section 5.2.1.4, "About Setting a Patch Path Variable in a Server Start Script"
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5.2.1.1 Default Script that Defines Class and Library Paths for All WebLogic
Domains and Servers
When a WebLogic Server instance is started, several startup scripts are executed. One
of the tasks performed by these scripts is to define class and library paths used by the
system, including the WebLogic system classpath. By default, all WebLogic Server
instances use the class and library path definitions set in one of the following scripts:
Windows:
WL_HOME\common\bin\commEnv.cmd

UNIX:
WL_HOME/common/bin/commEnv.sh

In UNIX environments, if you want to run commEnv.sh
manually from the command line or invoke it from a custom server
startup script, you must use the following syntax:

Note:

. WL_HOME/common/bin/commEnv.sh
or
. ./commEnv.sh (if you are already located in the bin directory)

5.2.1.2 Default Patch Path Environment Variables
The commEnv script includes default definitions for the environment variables
described in Table 5–2. By default, these patch path variables are in effect for every
WebLogic Server instance that is started, and they point at patches that are to be
inserted into class and library paths.
Table 5–2

Patch Path Variables Defined in the commEnv Script

This variable

Is set to the location of

PATCH_CLASSPATH

The patch manifest JAR file for the default patch profile
(weblogic_patch.jar)
This JAR file contains references to classes in the patch JAR files to
be loaded into the WebLogic system classpath. For example, the
default definition in the commEnv script for Windows is specified as
follows:
if "%PATCH_CLASSPATH%" == "" set PATCH_CLASSPATH=
%WLS_PATCH_CLASSPATH%;%WLW_PATCH_CLASSPATH%
Note: Most patches provided by My Oracle Support are WebLogic
system classpath patches referenced by PATCH_CLASSPATH.
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Table 5–2 (Cont.) Patch Path Variables Defined in the commEnv Script
This variable

Is set to the location of

WEBLOGIC_
EXTENSION_DIRS

The WebLogic extension directory patch manifest JAR file for the
default patch profile (weblogic_ext_patch.jar)
This file contains references to classes in the patch JAR files to be
loaded into the classpath of an application deployed on WebLogic
Server. For example, the default definition in the commEnv script
for Windows is specified as follows:
if "%WEBLOGIC_EXTENSION_DIRS%" == ""
set WEBLOGIC_EXTENSION_DIRS= %BEA_HOME%\
patch_wls1030\profiles\default\sysext_manifest_classpath
Note: This variable is reserved for use by products that require the
classes in a patch JAR file to be loaded into the classpath of an
application that is deployed on WebLogic Server. Currently, this
mechanism for patching deployed applications is not used with
WebLogic Server 9.1.

PATCH_LIBPATH
(UNIX only)

The native folder in the installation-level directory for the default
patch profile
This folder contains files to be loaded into the system library path
through the LIBPATH environment variable. For example, the
default definition in the commEnv script for UNIX is specified as
follows:
if [ "${PATCH_LIBPATH}" = "" ];
then PATCH_LIBPATH=${BEA_HOME}
/patch_wls1030/profiles/default/native

PATCH_PATH
(Windows only)

The native folder in the installation-level patch directory for the
default patch profile
This folder contains files to be loaded into the system path through
the PATH environment variable. For example, the default definition
in the commEnv script for Windows is specified as follows:
if "%PATCH_PATH%" == "" set PATCH_PATH=
%BEA_HOME%\patch_wls1030\profiles\default\native

5.2.1.3 How Patch Path Variables Are Inserted into Class and Library Paths
Within the commEnv script, the patch path variables described in Table 5–2 are inserted
into statements that set the system classpath, library path, and so on, as appropriate.
For example, the following default statement in the commEnv script sets the WebLogic
system classpath. The variable PATCH_CLASSPATH, at the beginning of the classpath
definition, is shown in bold.
set WEBLOGIC_CLASSPATH=%PATCH_CLASSPATH%;%JAVA_HOME%\lib\tools.jar;
%WL_HOME%\server\lib\weblogic_sp.jar;%WL_HOME%\server\lib\weblogic.jar;
%WL_HOME%\server\lib\webservices.jar

When the commEnv script is executed at server start time, the classes and library files
referenced by these patch path variables are loaded, overriding any classes or library
files of the same name that are listed later in the classpath or path statement.
Figure 5–2 shows a patch JAR file that contains classes referenced through the PATCH_
CLASSPATH environment variable and loaded into the WebLogic system classpath by
the commEnv script.
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Figure 5–2 Patch JAR File Classes Referenced by PATCH_CLASSPATH Variable

5.2.1.4 About Setting a Patch Path Variable in a Server Start Script
If the patch path variables described in Section 5.2.1.1, "Default Script that Defines
Class and Library Paths for All WebLogic Domains and Servers" were defined in a
script, such as startWebLogic or setDomainEnv, that you executed earlier to start
instances of WebLogic Server, the existing definitions for those server instances are
retained; they are not overridden by the variable definitions in commEnv.
For example, if the setDomainEnv script for the MyTestDomain domain contains a
definition for the PATCH_CLASSPATH variable that is used by all WebLogic Server
instances in MyTestDomain, the definition of PATCH_CLASSPATH in the commEnv
script is overridden for those server instances. For this reason, it is important that if
you add a patch path variable definition to a start script, that the definition is placed
before the statement that invokes another start script.
It is important for each WebLogic Server instance to start properly with any required
patches. If your environment requires you to define one of the patch path variables
with which you start your WebLogic Server instances, you must understand the
following:
■

■

The sequence in which scripts are executed, by default, in a product installation
environment. See Section 5.2.1.4.1, "Sequence in Which Start Scripts Are Executed."
Placeholders for defining patch path variables in the default start scripts produced
by the Configuration Wizard. See Section 5.2.1.4.2, "Placeholders for Defining
Patch Path Variables in Default Scripts."

5.2.1.4.1 Sequence in Which Start Scripts Are Executed After you understand the sequence
in which the start scripts in your environment are executed, and the locations from
which start scripts are invoked, you can determine the script that must be changed and
ensure that the correct values are assigned to all required patch path variables for all
target server instances.
A default set of scripts are provided to start WebLogic Server instances and to set
variables for each WebLogic domain and the Oracle product installation.
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These scripts are executed in a specific order, which is determined by the content of
each script.
Table 5–3 identifies:
■

Table 5–3

The default set of scripts that are created for a server, WebLogic domain, and
product installation

■

The function of each script

■

The order in which the scripts are executed

Default Set of Scripts in a Product Installation

This script

Performs this function

When Executed

In the bin directory of your
WebLogic domain:

Starts Managed Servers in the domain.
Patch path variables defined in this script
are used by all Managed Servers started by
the script.

When a domain is configured with
Managed Servers, such as in a cluster,
this script is the first one executed by
default.

Windows:
startManagedWebLogic.cmd

This script invokes the
startWebLogic script.

UNIX:
startManagedWebLogic.sh
In the bin directory of your
WebLogic domain:
Windows:
startWebLogic.cmd
UNIX:
startWebLogic.sh

In the bin directory of your
WebLogic domain:
Windows:
setDomainEnv.cmd
UNIX:

Starts WebLogic Server instances in a
domain. Patch path variables defined in
this script are in effect for all domain
servers except for those that are started.

If the domain is configured with
Managed Servers, this script is
invoked, by default, by the
startManagedWebLogic script.

For example, if the previously-executed
startManagedWebLogic script contains
patch path variable definitions for
Managed Servers, then the patch path
variable definitions appearing in the
startWebLogic script are overridden for
Managed Servers started by the
startManagedWebLogic script.

The startWebLogic script invokes
the setDomainEnv script.

Sets the domain-wide environment for
starting and running WebLogic Server
instances. Patch path variables defined in
this script are in effect for all domain
servers not otherwise started by the
startManagedWebLogic script,
startWebLogic script, or other
server-specific script.

By default, this script is invoked by
the startWebLogic script.

setDomainEnv.sh
In the WL_
Sets domain-wide environment for starting
HOME\common\bin
and running WebLogic Server instances.
directory of your installation: Patch path variables defined in this script
are in effect for all domain servers not
Windows:
otherwise started by the
startManagedWebLogic script,
commEnv.cmd
startWebLogic script, or other
server-specific script.
UNIX:
commEnv.sh

The setDomainEnv script contains
an invocation to the commEnv script
to define settings for the domain that
are not otherwise defined in the
server start scripts or in the
setDomainEnv script.
By default, this is the final script that
is invoked to define settings for
servers that are started and that run
on the installation.
Note: In UNIX environments, if you
want to run commEnv.sh manually
from the command line or invoke it
from a custom server startup script,
you must use the following syntax:
. WL_HOME/common/bin/commEnv.sh
or, if you are already located in the
bin directory:
. ./commEnv.sh
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5.2.1.4.2 Placeholders for Defining Patch Path Variables in Default Scripts When you create a
WebLogic domain using the Configuration Wizard, note the following about the
placeholders for defining patch path variables in the scripts that are created for that
domain:
■

The setDomainEnv script contains the following lines, which are commented out
by default:
@REM If you want to override the default Patch Classpath, Library Path
and Path for this domain,
@REM Uncomment the following lines and add a valid value for
the environment variables
@REM set PATCH_CLASSPATH=[myPatchClasspath] (windows)
@REM set PATCH_LIBPATH=[myPatchLibpath] (windows)
@REM set PATCH_PATH=[myPatchPath] (windows)
@REM PATCH_CLASSPATH=[myPatchClasspath] (unix)
@REM PATCH_LIBPATH=[myPatchLibpath] (unix)
@REM PATCH_PATH=[myPatchPath] (unix)

The Configuration Wizard provides these commented lines as an aid to helping
you place definitions for patch path variables. For example, if you want to point
the domain to the patch JARs in the custom profile MyProfile, you might
uncomment the placeholder for the PATCH_CLASSPATH variable and define it as
follows:
PATCH_CLASSPATH=%BEA_HOME%\patch_wls1001\profiles\MyProfile\sys_manifest_
classpath\weblogic_patch.jar

Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

Refer to Table 5–2 for the definitions of these variables that are included by default
in the commEnv script.
To help with adding definitions of patch path variables, Smart Update provides
the Start Script Editor, described in Section 5.4, "Using the Start Script Editor."
A start script should reference no more than one patch
manifest JAR file for WebLogic system-level classes. If a start script
references more than one such file, unpredictable behavior may occur
at run time.

Note:

■

The startWebLogic and startManagedWebLogic start scripts produced by
the Configuration Wizard do not contain placeholders for defining patch path
variables. If you add a definition for one or more of these variables to one of these
scripts, be sure that you understand which WebLogic Server instances are affected.
By minimizing the number of start scripts to which you add patch path variable
definitions, you reduce the amount of maintenance required for those scripts if
you change or upgrade the maintenance level or version of the installed product.
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5.3 Modifying a Start Script
The specific tasks you must perform to ensure that a start script references the classes
or library files patches in a profile depend on whether the scope of those patches is
intended for all WebLogic domains, and servers running on the product installation, or
only for a specific domain, or server in that installation.
If you use custom start scripts, or if you need to limit the scope of a patch to a specific
WebLogic domain, server, you must modify your start scripts as follows:
■

■

To insert patches into the system classpath or library path for all server instances
that run on a product installation, if you use custom start scripts, you must add
references to the default patch profile to those scripts.
To limit the scope of a patch to a specific WebLogic domain, or server, you must
perform two tasks:
1.

Create a custom patch profile, to which the patches are applied for the
domain, or server that runs on a product installation.

Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.
2.

In the start script(s) for the corresponding WebLogic domain or server, add
references to the custom patch profile.

To learn how to modify start scripts so that the class and library path patches you have
applied are properly used, see Section 5.1, "Overview," which provides the following
information:
■

■

The distinction between patch files that must be dynamically loaded into the
system classpath or library path and patches that are automatically in effect
installation-wide
Where, on your system, Smart Update places patch file content when you apply a
patch

See also Section 5.2.1, "About Pointing Start Scripts at Patches," to find out how the
default scripts created by the Configuration Wizard automatically insert class and
library patches into the system classpath and library path. Understanding this process
is important if you need to change your scripts so that they reference class and library
patches appropriately.
You must modify your scripts in the following situations:
■
■

You do not use the default scripts in your environment.
You need to limit the scope of a patch to a particular WebLogic domain or server
start script.

Table 5–4 provides information about changing a start script.
Table 5–4

Changing Start Scripts

For information about

Read the following topic

Using the Start Script Editor

Section 5.4, "Using the Start Script
Editor"
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Table 5–4 (Cont.) Changing Start Scripts
For information about

Read the following topic

Opening a start script

Section 5.4.3, "Opening a Start Script"

The modifications required for start scripts to
Section 5.5, "Pointing All Domains and
reference the class and library path patches that are in Servers at Patches Through Custom
effect for all WebLogic domains and servers
Scripts"
The modifications required for starts scripts to
Chapter 6, "Patching Individual
reference the class and library path patches that are in Applications, Domains, or Servers"
effect for a specific WebLogic domain or server
Creating a custom patch profile, which you must do
before modifying scripts to point a WebLogic domain
or server at patches

Section 6.3, "Creating a Custom Patch
Profile"

5.4 Using the Start Script Editor
The Start Script Editor is a tool, provided by Smart Update, for locating start scripts in
your environment and creating definitions for patch path variables in them. Smart
Update maintains scripts in multi-product environments with different patch levels as
expressed in combinations of default patch profile and custom patch profiles.
Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

Note:

Accordingly, in the bottom pane, the script snippet shown is also product-specific, and
targets myCustomProfile. A different snippet is provided for each type of path. These
paths include classpath, WebLogic extended classpath, and native.

5.4.1 Script Snippet for Windows
SET PATCH_CLASSPATH=%BEA_HOME%\patch_wls1001\profiles\myCustomProfile\sys_
manifest_classpath\weblogic_patch.jar
SET WEBLOGIC_EXTENSION_DIRS=%BEA_HOME%\patch_
wls1001\profiles\myCustomProfile\sysext_manifest_classpath
SET PATCH_LIBPATH=%BEA_HOME%\patch_wls1001\profiles\myCustomProfile\native
SET PATCH_PATH=%BEA_HOME%\patch_wls1001\profiles\myCustomProfile\native

5.4.2 Script Snippet for UNIX
export PATCH_CLASSPATH=${BEA_HOME}/patch_wls1001/profiles/myCustomProfile/sys_
manifest_classpath/weblogic_patch.jar
export WEBLOGIC_EXTENSION_DIRS=${BEA_HOME}/patch_
wls1001/profiles/myCustomProfile/sysext_manifest_classpath
export PATCH_LIBPATH=${BEA_HOME}/patch_wls1001/profiles/myCustomProfile/native
export PATCH_PATH=${BEA_HOME}/patch_wls1001/profiles/myCustomProfile/native
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This procedure describes the steps for using the Start Script Editor for WebLogic
Platform 9.x, ALSB 2.5, and ALSB 2.6. To use the Start Script Editor, complete the
following steps:
1.

In Smart Update, select a target installation from the Target Installation panel.

2.

Choose Patches > Start Script Editor.

3.

In the Start Script Editor dialog box:
a.

Choose the patch profile to which the WebLogic domain or server will point.
For information about using a custom patch profile to scope a patch to a
specific WebLogic domain or server, see Chapter 9, "Best Practices for
Distributing Patches."

b.

Choose the product for which you are editing a start script. See Figure 5–3.
If you select Workshop for WebLogic, your WebLogic domain
does not automatically download any of the WebLogic Server patches
that might exist in that custom profile.

Note:

c.

Open the start script you want to modify.
For detailed instructions, see Section 5.4.3, "Opening a Start Script."

d.

Add the appropriate patch path variable definition to your patch profile.
The Start Script Editor provides code snippets with suggested definitions for
the PATCH_CLASSPATH, WEBLOGIC_EXTENSION_DIRS, PATCH_LIBPATH,
and PATCH_PATH variables, all of which are customized for the
previously-selected patch profile. You may want to modify these definitions,
however, depending on your needs:

e.

–

If you are modifying your script to point to the patches in the default patch
profile, see Section 5.5, "Pointing All Domains and Servers at Patches
Through Custom Scripts," for instructions.

–

If you are modifying your script to point to the patches in a custom patch
profile, see Chapter 6, "Patching Individual Applications, Domains, or
Servers," to learn how to create a custom patch profile and add pointers to
that profile to the start script for a WebLogic domain or server.

If your custom patch profile myCustomProfile contains both WebLogic
Server and Workshop for WebLogic patches, and you want all of them to be
active in a specific domain, you must first edit the domain start script to
include a product-specific tokenized path declaration, similar to the snippets,
but modeled on the declarations in setPatchEnv.cmd:
For example:
WLS_PATCH_CLASSPATH=

and

WLW_PATCH_CLASSPATH=

instead of:
PATCH_CLASSPATH=

You must also include a concatenation statement similar to the one found in
setPatchEnv.cmd:
set PATCH_CLASSPATH=%WLS_PATCH_CLASSPATH%;%WLW_PATCH_CLASSPATH%

Repeat this for each path type.
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f.

Save the start script.
When adding a definition of a patch path variable to a start
script, ensure that the definition appears before any statement that
invokes another start script. For example, if you add a patch path
variable definition to the setDomainEnv script, add it before the
statement that invokes the commEnv script. This placement ensures
that the definition you add is not overridden by a definition appearing
in any of the start scripts that are subsequently invoked.

Note:

Smart Update does not enforce or control how you modify start scripts. If, however,
you use the start scripts that are created by default by standard tools such as the
Configuration Wizard, and maintain them in the default locations determined by those
tools, Smart Update can provide a more structured and predictable way to locate the
appropriate start scripts that must be modified for the purposes of pointing to the
patches in a patch profile.
The Start Script Editor dialog box is not a wizard; it does not perform the following
tasks:
■

Detect all appropriate scripts that must be modified. If you use the start scripts
provided, by default, by the Configuration Wizard, the Start Script Editor can help
you find them quickly.
If you have customized your server and domain start mechanisms, you might
need to take additional steps beyond working with the Start Script Editor to make
all the necessary changes.

■

■

Modify start scripts. The Start Script Editor displays scripts and suggests additions
to them, but you make the final decisions about which modifications to make and
where to save them.
Create backup copies of your start scripts.

5.4.3 Opening a Start Script
When you open a start script, by clicking Open in the Start Script Editor dialog box,
Smart Update displays the Open Start Script dialog box. Use this dialog to locate the
start script in which you want to add pointers from a WebLogic domain, Managed
Servers, a cluster, or an individual server to the patches in a patch profile.
In the Start Script Editor dialog box, the icons described in Table 5–5 are used to guide
you to the directory containing the start script you want to modify.
Table 5–5
This icon

Open Start Script Dialog Box Icons
Marks
The parent directory, within a WebLogic domain, of the bin
subdirectory in which, by default, the scripts you need to change
reside.
A domain subdirectory, such as bin, in which script files reside. To
open a subdirectory and display the scripts in it, click this icon.

If you use the directory structure created for a domain by the Configuration Wizard,
Smart Update guides you to the directories containing the start scripts that you need
to change.
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For information about locating a specific start script to modify, see the following
topics:
■

Section 5.4.3.1, "Modifying the Domain Start Script"

■

Section 5.4.3.2, "Modifying the Start Script for All Managed Servers or a Cluster"

■

Section 5.4.3.3, "Modifying the Start Script for a Specific Server"

5.4.3.1 Modifying the Domain Start Script
To modify the start script for a domain, select the setDomainEnv or startWebLogic
script in the domain bin subdirectory. Figure 5–3 shows how to select the
setDomainEnv script on a Windows system.
Figure 5–3 Selecting the setDomainEnv Script in the Select Start Script Dialog Box

The setDomainEnv script contains placeholders for definitions of the PATCH_
CLASSPATH, PATCH_LIBPATH, and PATCH_PATH variables. For information about
modifying this script, see Table 5–6.
Table 5–6

Modifying Scripts

For information about modifying

See the following section

The placeholders for definitions of the
PATCH_CLASSPATH, PATCH_LIBPATH,
and PATCH_PATH variables

Section 5.2.1.4.2, "Placeholders for Defining Patch
Path Variables in Default Scripts"

This script to point to the patches in the
default patch profile

Section 5.5, "Pointing All Domains and Servers at
Patches Through Custom Scripts"

This script to point to the patches in a
custom patch profile

Section 6.4, "Pointing Domains and Servers at a
Custom Patch Profile"

5.4.3.2 Modifying the Start Script for All Managed Servers or a Cluster
To modify the start script for all Managed Servers in a domain, which by default
includes all servers in a cluster, select the startManagedWebLogic script in the
domain bin subdirectory, as Figure 5–4 shows on a Windows system.
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Figure 5–4 Selecting the startManagedWebLogic Script in the Select Start Script Dialog
Box

For information about modifying this script, see Table 5–7.
Table 5–7

Modifying Script

For information about modifying this
script to

See the following section

Point to the patches in the default patch
profile

Section 5.5, "Pointing All Domains and Servers
at Patches Through Custom Scripts"

Point to the patches in a custom patch profile

Section 6.4, "Pointing Domains and Servers at a
Custom Patch Profile"

5.4.3.3 Modifying the Start Script for a Specific Server
To modify the start script for a particular server in a domain, select the
uniquely-named start script for that server in the domain bin subdirectory. Figure 5–5
shows how to select the start script startWebLogicServer1 on a Windows system.
Figure 5–5 Selecting a Server Start Script in the Select Start Script Dialog Box

For information about modifying this script, see Table 5–8.
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Table 5–8

Modifying Start Script

For information about modifying this script
to
See the following section
Point to the patches in the default patch profile Section 5.5, "Pointing All Domains and Servers
at Patches Through Custom Scripts"
Point to the patches in a custom patch profile

Section 6.4, "Pointing Domains and Servers at
a Custom Patch Profile"

5.5 Pointing All Domains and Servers at Patches Through Custom
Scripts
It is important to ensure that class and library patches are properly loaded into the
class and library paths used in your domains. If the scripts used in your WebLogic
domains to start servers or set up the environment do not invoke the default commEnv
script, as described in Section 5.2.1.1, "Default Script that Defines Class and Library
Paths for All WebLogic Domains and Servers," you should modify those scripts as
follows:
■

■

Define any environment variables that point to the class and library patches
applied to the default patch profile
Add these environment variables to the following paths:
–

WebLogic system classpath

–

Classpath used by applications deployed on WebLogic Server, as required by a
product

–

Library path

Ensure that you add this functionality of the default commEnv script to your own
scripts through any of the following methods:
■

■

Centralize, in one script, the code that points to patches in the default patch
profile. Then invoke this central script from all start scripts. Oracle recommends
this approach because it simplifies the task of maintaining the code that points to
patches and minimizes the number of changes that must be made to scripts as
your environment changes.
Make a copy, in every start script, of the code that points to the patches you have
applied to the default patch profile. By making sure that this code is included in
every start script, you guarantee that all servers in your domains point to the
patches that have been applied. As you add servers or change the configuration of
your environment, however, the task of properly maintaining your start scripts
becomes increasingly complex.

5.5.1 Pointing Domains and Servers at Patch JARs in the Default Patch Profile for the
WebLogic System Classpath
When the domains and servers in your environment are started, the patch JARs that
have been applied to the default patch profile should be inserted into the WebLogic
system classpath. To ensure that the patch JARs are inserted into this classpath
properly, you must add, to your start script, the code described in this section.
1.

Add a default definition of the PATCH_CLASSPATH environment variable. For
example:
if "%PATCH_CLASSPATH%" == "" set PATCH_CLASSPATH=BEA_HOME\patch_
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wls1001\profiles\default\sys_manifest_classpath\weblogic_patch.jar

This definition enables individual servers or domains to override this definition, if
those servers or domains must point to the patches in a custom patch profile. In
this definition, BEA_HOME represents the Middleware home directory path. You
can specify an absolute path, or use an environment variable, which you have
previously defined (recommended).
2.

Add PATCH_CLASSPATH to the beginning of the statement that sets the WebLogic
system classpath. For example:
set WEBLOGIC_CLASSPATH=%PATCH_CLASSPATH%;%JAVA_HOME%\lib\tools.jar;
%WL_HOME%\server\lib\weblogic_sp.jar;%WL_HOME%\server\lib\weblogic.jar;
%WL_HOME%\server\lib\webservices.jar

This ensures that classes in the patch JARs override existing, same-named classes
appearing later in the classpath.
If your default patch profile contains patch JARs for applications that are deployed
on WebLogic Server for a product, you can define the WEBLOGIC_EXTENSION_
DIRS environment variable to point to the patch JARs for that application as
follows:
if "%WEBLOGIC_EXTENSION_DIRS%" == "" set WEBLOGIC_EXTENSION_DIRS=
%BEA_HOME%\patch_wls1001\profiles\default\sysext_manifest_classpath

The WEBLOGIC_EXTENSION_DIRS variable is reserved for
use by products that require the classes in a patch JAR file to be
loaded into the classpath of an application that is deployed on
WebLogic Server. This mechanism for patching deployed applications
is not currently being used with WebLogic Server 9.1.

Note:

5.5.2 Pointing Domains and Servers at Library Patches in the Default Patch Profile
It is important to ensure that the native files that have been applied to the default
patch profile are inserted into the system library path, whenever any of the domains or
servers in your environment are started. To ensure that these files are inserted
properly, add the code provided in this section to the script that you have chosen to
point to the patches applied to the default patch profile.
To add this code to your script, follow the appropriate instructions:
■

Section 5.5.2.1, "For UNIX Systems"

■

Section 5.5.2.2, "For Windows Systems"

5.5.2.1 For UNIX Systems
1.

Add a default definition of the PATCH_LIBPATH environment variable. For
example:
if [ "${PATCH_LIBPATH}" = "" ]; then
wls1001/profiles/default/native

PATCH_LIBPATH=${BEA_HOME}/patch_

This definition enables individual servers or domains to override this definition, if
those servers or domains must point to the patches in a custom patch profile.
2.

Add PATCH_LIBPATH to the beginning of the statement that sets the system
library path for your system. To make this script usable for all the operating
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systems and hardware architectures supported by products, you can provide
individual statements that set the paths for each of those systems. For example:
if [ -n "${LIBPATH}" ]; then
LIBPATH=${LIBPATH}:${WL_HOME}/server/native/aix/ppc
else
LIBPATH=${WL_HOME}/server/native/aix/ppc
fi
LIBPATH=${PATCH_LIBPATH}:${LIBPATH}
export LIBPATH

This ensures that library file patches in the default patch profile override existing,
same-named files appearing later in the path.

5.5.2.2 For Windows Systems
1.

Add a default definition of the PATCH_PATH environment variable. For example:
if "%PATCH_PATH%" == "" set PATCH_PATH=%BEA_HOME%\patch_
wls1001\profiles\default\native

This definition enables individual servers or domains to override this definition, if
those servers or domains must point to the patches in a custom patch profile. In
this definition, BEA_HOME represents the Middleware home directory path. You
can specify an absolute path, or use an environment variable, which you have
previously defined (recommended).
2.

Add the variable PATCH_PATH to the beginning of the statement that sets the
system library path. To make this script usable for all the operating systems and
hardware architectures supported by products, you can provide individual
statements that set the paths for each of those systems. For example:
if "%WL_USE_X86DLL%" == "true" set PATH=%PATCH_PATH%;%WL_
HOME%\server\native\win\32;
%WL_HOME%\server\bin;%JAVA_HOME%\jre\bin;%JAVA_HOME%\bin;%PATH%;%WL_
HOME%\server\native\win\32\oci920_8

This ensures that library file patches in the default patch profile override existing,
same-named files appearing later in the path.

5.6 Module Patching
WebLogic Server (10.0 and later releases) and OSGi-based products (for example,
Oracle Enterprise Repository) incorporate a modular approach for developing and
distributing the software. Patches are provided to update such modules.
OSGi-based products are built on microServices Architecture
(mSA) and they use an Open Services Gateway initiative (OSGi)-based
framework to manage services that are provided by modules or
feature sets.

Note:

Modules can be of two types, common and product-specific. Common modules are
shared by multiple products and product-specific modules are used only by a product.
Smart Update displays a warning message when you attempt to apply a patch for a
common module. You can click Yes, if you want to apply a patch to all the products;
otherwise, click No. Follow the instructions on the dialog box.
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A run-time instance of WebLogic Platform can contain only a single version of a
module. Therefore, to ensure that a given module version is patched correctly, all
products used together should be patched consistently relative to a module associated
with more than one of the products.
In WebLogic Server, module patches are added through classpath, but in OSGi-based
products, patches are loaded using an OSGi-based launcher.

5.6.1 Module Patching in WebLogic Server
Products such as WebLogic Server load modules to run-time containers through the
classpath. For more information about loading patches to a classpath, see Section 5.2,
"Classpath, Extended Classpath, and Native Library Patches."

5.6.2 Module Patching in OSGi-Based Products
OSGi-based products load modules to run-time containers through the OSGi-based
launcher. The launcher determines the necessary modules and the sequence of
modules to be loaded at run time. It also determines whether a module is patched for a
given product. If a module is patched, the updated version is loaded and used. The
scope of a module patch is specific to the product and to the patch profile. This
provides the necessary granularity to ensure that a patch is specific to one product and
not to all products in the same Middleware home directory.
In an OSGi-based product installation, you can see two directories for
modules—common modules (MW_HOME\modules) and product-specific modules (for
example, MW_HOME\wlevs20\modules). Figure 5–6 shows the structure of these
directories.
Note: Starting from the Oracle Fusion Middleware 11gR1 release,
MW_HOME is the new term for BEA_HOME.
Figure 5–6 Installation-Level Directory Structure for WebLogic Event Server
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5.7 Native Binaries and Other Artifacts Patches
Native binaries and other artifacts are in effect for all applications, domains and
servers, as described in Section 5.1.2, "Patches That Replace Resources For All
Applications, Domains, and Servers."

5.8 Shared Archive Patches
This section describes how shared archive patches are deployed and referenced by
applications.

5.8.1 Overview
Shared archive patches were introduced to support shared libraries, and in particular
WebLogic library modules. Unlike other artifacts installed in the product directory,
applications can use shared archives by direct name and version references, rather
than relying on a well-known location. This implies that a default installation of a
shared archive has an installation-wide (or domain-wide) scope until superseded by a
custom installation of the same shared archive into a specified profile.
To activate a shared archive patch after application to the default or a custom profile in
Smart Update, you must first deploy the patched archive in the affected domain, and
potentially modify the application description to make specific reference to it.
Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

Shared archive patches can be applied to an entire domain (or all domains running in a
given installation) or selected applications in a domain. To affect potentially all
domains in an installation, apply the shared archive patch to the default profile in
Smart Update.
For more information on this topic, see Section 5.8.2, "Default Application of Shared
Archive Patches."
To affect only a specific application, you should apply the patch to a custom profile
and update the archive references in the application descriptor. This approach would
enable you to maintain unique patch profiles for each application that utilizes shared
libraries, if necessary.
For more information on this topic, see Section 5.8.3, "Activating Shared Archive
Patches in Custom Profiles with Application Scope."

5.8.1.1 Archive Replacement Compared with Insertion
When a shared archive patch is applied, it either replaces an entire archive (or installs
an entirely new archive) or partially updates the archive (by insertion).
Which operation is used is determined by the patch creator. If you are not sure, contact
My Oracle Support.

5.8.1.2 Patch Removal
When you remove a patch, you must undeploy the patch explicitly in addition to
perform patch removal using Smart Update.
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5.8.1.3 For More Information
To learn more about deploying and undeploying shared libraries, see Deploying
Applications to Oracle WebLogic Server. To learn more about shared libraries, see
Developing Applications for Oracle WebLogic Server.

5.8.2 Default Application of Shared Archive Patches
When a shared archive patch is applied in Smart Update to the default profile, it is
treated by the Patch Management System as applicable to the entire installation.
Consequently, when you apply a shared archive patch to the default profile, the patch
is applied to all custom profiles (if any) as well. Smart Update warns you that the
patch will be applied to the entire product installation. If you click Continue, the patch
is applied to all profiles.
The actual write location of the patched shared archive is usually relative to the
product shared library directory. You may need this information, depending on how
you choose to deploy it.
Shared libraries are located under:
■

WL_HOME/common/deployable-libraries

■

WL_HOME/portal/lib/modules

■

WL_HOME/servicebus/lib

■

WL_HOME/integration/common/lib/installation

Typically, portal-shared archive patches are installed under maintenance/default in
the above common and portal shared library directories. Other products may institute
differing default patch directory structures. If you need further guidance for a specific
patch, consult My Oracle Support.
If the patch is replacing an existing archive and it is already deployed, you just need to
restart the server. If the patch contains a new version, or is to be installed under a
different directory, you must deploy the patched archive. Deployment can be done
using the WebLogic Server console, custom WLST script, or by directly updating
config.xml for the target domain.
On successful deployment of the patched archive, it (including the name, specification,
and version number) is visible in the WebLogic Server administration console.
If you leave the library module manifest untouched, all references to the library
module remain intact and all applications in the domain immediately take advantage
of new functionality without additional manual configurations to application
descriptors.

5.8.3 Activating Shared Archive Patches in Custom Profiles with Application Scope
In some cases, you may want to control and apply a patch at a certain level to selected
applications. To apply a shared archive patch in such a scenario, create a custom
profile and apply shared archive patches to that custom profile only.
To distinguish one version of a shared library patch from another and to allow
different versions of a shared library to coexist in a single domain, versions can be
distinguished by unique names or unique implementation versions, or both.
After applying a shared archive patch to a custom profile in Smart Update, two steps
are required to activate it for the application you intend to patch:
1.

Deploy the patch in the custom profile.
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2.

Update the application descriptor to reference the specific version of the patched
archive.

The steps to deploy the shared archive patch in a custom profile are the same as those
for shared archive patches in the default profile, except that in the custom profile case
the patch is located in the following directory:
MW_HOME/patch_
weblogicversion/profile/custom-profile-name/archives
For example: MW_HOME/patch_wls1001/profile/customProfile

5.8.3.1 Updating Application Descriptors
To support a variety of application-scoped patch scenarios, shared archive patches
may be configured when they are created to force unique naming or unique
versioning, or both, when the patch is installed. Smart Update detects this if the patch
is applied to a custom profile, and may modify the archive's extension-name or
implementation version, or both, in the archive manifest at that time.
If a patch was created to force a unique name, the patch install process appends the
string "-patch_custom-profile-name" to the manifest extension-name.
If a patch was created to force a unique implementation version, the patch install
process decrements the version's last digit and appends a digit N where N is the patch
profile ID as defined in patch-registry.xml. For example, an implementation
version of 9.2.0.1 might become 9.2.0.0.1.
In general, application descriptors (weblogic.xml for WAR and
weblogic-application.xml for EAR) do not require a specific version. Instead,
they look for the most recent (highest) version. To reference a specific version of a
shared library, you must set the Boolean <exact-match> to true.
For example, in the following section of weblogic-application.xml for a 9.2.0.0.1
shared archive patch, note that <exact-match> is set to true.
<weblogic-application xmlns="http://www.bea.com/ns/weblogic/90"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<library-ref>
<library-name>wlp-tools-admin-app-lib</library-name>
<specification-version> 9.2.0 </specification-version>
implementation-version> 9.2.0.0.1 </implementation-version>
<exact-match> true </exact-match>
</library-ref>
</weblogic-application>
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6
Patching Individual Applications, Domains,
or Servers

6

Smart Update enables you to point a domain or server at a set of patches that are not
necessarily intended for the entire installation by using a custom patch profile.
Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

This section includes the following topics:
■

Section 6.1, "About Patching Domains or Servers"

■

Section 6.2, "About Patching Applications, Domains, or Servers"

■

Section 6.3, "Creating a Custom Patch Profile"

■

Section 6.4, "Pointing Domains and Servers at a Custom Patch Profile"

■

Section 6.5, "Managing Custom Patch Profiles in a Node Manager Environment"

6.1 About Patching Domains or Servers
By default, when you download and apply patches, those patches are in effect for the
entire target installation. Every domain and server that is configured to run from such
an installation runs against the patches applied to it. Sometimes, however, individual
servers or domains within a production environment need to run at different patch
levels. To accommodate this need, Smart Update enables you to point individual
domains, servers, or clusters at specific patches that are not necessarily in effect
installation-wide.
For example, if you have (a) multiple products installed in a Middleware home
directory, and (b) domains that exclusively use only one of those products, it is
recommended that you point those domains at only those patches that have been
applied to the specific product used by the domain.
At a high level, the work required to point an individual domain or server at one or
more patches that are not intended to be in effect installation-wide can be summarized
as a three-step procedure:
1.

Create a custom patch profile.

2.

In the appropriate start script for the corresponding domain or server, insert a
pointer to the custom patch profile.
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3.

Apply the desired patches to the custom patch profile.

Figure 6–1 provides a detailed version of this procedure.
Figure 6–1 How to Point an Individual Domain, Cluster, or Server at a Custom Patch
Profile

6.2 About Patching Applications, Domains, or Servers
Smart Update enables you to apply Shared Archive patches to specific applications.
When you apply a shared archive patch to a default patch profile, it is installed
automatically. However, when you apply an application-scoped patch to a custom
patch profile, it should be explicitly deployed. See Section 5.8, "Shared Archive
Patches."

6.2.1 How Custom Profiles Can Patch Individual Domains, Servers, and Applications
By default, all patches included in the default patch profile are in effect for all domains
and servers in an entire installation. The patches in a custom patch profile, however,
can be put into effect for any subset of domains or servers within an installation. As
noted in Section 5.1.2, "Patches That Replace Resources For All Applications, Domains,
and Servers," patches that replace system-wide resources cannot be selectively targeted
by a subset of domains or servers. Such selective targeting is possible, however, for
patches with classes or library files that are loaded through a start script and thereby
supersede existing, same-named resources in the system.
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Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

The following sections provide background information about how custom patch
profiles can be used to patch individual domains and servers:
■

Section 6.2.2, "How a Domain or Server Can Point to a Patch in a Custom Profile"

■

Section 6.2.3, "Best Practices for Using Custom Patch Profiles"

6.2.2 How a Domain or Server Can Point to a Patch in a Custom Profile
When you create a domain using the Configuration Wizard, the Configuration Wizard
creates the following scripts for the domain:
■

■

■

setDomainEnv—Script used to set domain-level environment variables,
including those used by all servers.
startWebLogic—Start script used by any WebLogic Server instances in the
domain that are not Managed Servers.
startManagedWebLogic—Start script used by Managed Servers in the domain,
including those in a cluster.
Note: For details, see Section 5.2.1.1, "Default Script that Defines
Class and Library Paths for All WebLogic Domains and Servers."

By default, the values of the PATCH_CLASSPATH, WEBLOGIC_EXTENSION_DIRS,
PATCH_LIBPATH, and PATCH_PATH variables provided in the product installation
script, commEnv, are used by all the server instances that run on that installation. If,
however, you override these values for any of the variables in a domain-level script,
the new values are used only by the WebLogic Server instances that are started by
those scripts.
The definition of a given patch variable should reference no
more than one patch manifest JAR. If multiple patch manifest JAR
files are referenced, unpredictable behavior may occur at run time.

Note:

Modifying the definition of a patch path variable in a start script is a convenient way
of pointing servers started by that script at the patches included in a custom patch
profile. For example, if you want to point a server at the WebLogic system classes in a
patch that has been applied to a custom patch profile, you simply add a definition of
the PATCH_CLASSPATH variable to that server start script, setting the variable to the
path of the patch manifest JAR file in the custom patch profile. Similarly, you can point
a server or domain at a native library file in a custom patch profile by adding a
reference to the directory in the custom patch profile that contains that native file. To
add this reference, you add a definition of the PATCH_PATH or PATCH_LIBPATH
variable to the start script for the appropriate server or domain.
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When adding a definition of a patch path variable to a start
script, ensure that the definition appears before any statement that
invokes another start script. For example, if you add a patch path
variable definition to the setDomainEnv script, add it before the
statement that invokes the commEnv script. This placement ensures
that the definition you add is not overridden by a definition appearing
in any of the start scripts that are subsequently invoked.

Note:

Smart Update does not enforce or control how you modify start scripts. But if you use
the start scripts that are created, by default, with standard tools such as the
Configuration Wizard, and maintain them in the default locations determined by those
tools, Smart Update can provide a structured and predictable method of locating the
start scripts that need to be modified and suggesting the specific changes that must be
made to those scripts.
Figure 6–2 shows two patch profiles used in an installation: the default patch profile
and a custom patch profile. In this figure:
■

■

The default patch profile includes patches 1, 2, and 3. By default, all domains and
servers running in the sample installation are pointing at it.
The custom patch profile includes patch 4. One server in the sample domain is
pointing at it.

Figure 6–2 How to Point an Individual Domain, Cluster, or Server at a Custom Patch
Profile

6.2.2.1 Example Use of PATCH_CLASSPATH to Point a Server at Patch Classes
The following PATCH_CLASSPATH variable references the patch manifest JAR file
weblogic_patch.jar, located in the custom profile ProductionServer1:
set PATCH_CLASSPATH=
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%BEA_HOME%\patch_wls1001\profiles\ProductionServer1
\sys_manifest_classpath\weblogic_patch.jar

When the preceding definition is added to the startWebLogic script for a given
domain, server instances that are started in that domain by that script load the class
files into the WebLogic server classpaths that are referenced by the weblogic_
patch.jar file in the ProductionServer1 custom profile. This classpath loading
occurs when the following line in the commEnv script is subsequently executed
(PATCH_CLASSPATH is shown in bold):
set WEBLOGIC_CLASSPATH=%PATCH_CLASSPATH%;%JAVA_HOME%\lib\tools.jar;
%WL_HOME%\server\lib\weblogic_sp.jar;%WL_HOME%\server\lib\weblogic.jar;
%WL_HOME%\server\lib\webservices.jar

Note: The weblogic_patch.jar in the ProductionServer1 profile
may reference a set of patch JAR files that is entirely different from the
set of patch JAR files referenced in the weblogic_patch.jar of the
default patch profile.

If you want a server in a domain, or any domain in an installation, to continue to point
to patches in the default patch profile, you do not need to change the start script for
that server or domain if you use the default scripts for servers and domains provided
by the Configuration Wizard. If, however, you want one or more servers or a domain
to point at a custom patch profile, ensure that the start script you modify affects only
the targeted servers or the domains.
For information about the sequence in which start scripts are executed, and how
particular definitions of patch path variables affect servers started by scripts with
patch path variable definitions, see Section 5.2.1.4.1, "Sequence in Which Start Scripts
Are Executed."

6.2.2.2 Pointing to Custom Patch Profiles in OSGi-based Products
In a text editor, open the start script for the server (for example, in a WebLogic Event
Server domain, startwlevs.cmd on Windows, startwlevs.sh on UNIX) and add
the -DBEAPatchProfile property to this script as follows:
if "%1" == "-dgc" goto rundgc
"%JAVA_HOME%\bin\java" -Dwlevs.home="%USER_INSTALL_DIR%" -Dbea.home="%BEA_HOME%"
-Dcom.bea.core.security.username=wlevs -Dcom.bea.core.security.password=wlevs
–DBEAPatchProfile=custProfile
-jar "%USER_INSTALL_DIR%\bin\wlevs_2.0.jar" %1 %2 %3 %4 %5 %6
goto finish
:rundgc
"%JAVA_HOME%\bin\java" %DGC_ARGS% -Dwlevs.home="%USER_INSTALL_DIR%"
-Dbea.home="%BEA_HOME%" -Dcom.bea.core.security.username=wlevs
-Dcom.bea.core.security.password=wlevs –DBEAPatchProfile=custProfile
-jar "%USER_INSTALL_DIR%\bin\wlevs_2.0.jar" %2 %3 %4 %5 %6
:finish

When the modified start script is executed, only those patches applied to the patch
profile specified in the script are referenced by the OSGi launcher.
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6.2.3 Best Practices for Using Custom Patch Profiles
This section provides important information about the use of custom patch profiles:
■

Section 6.2.3.1, "Avoiding Proliferation of Custom Profiles"

■

Section 6.2.3.2, "Modifying Domain and Server Start Scripts"

■

Section 6.2.3.3, "Removing Patches That Affect Installation-Wide Resources"
Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

6.2.3.1 Avoiding Proliferation of Custom Profiles
When you want to point a domain or server at a new set of patches you have
downloaded, try to apply the patches to an existing patch profile, if possible. To
change the set of patches at which a specific domain or server points, change the
content of the custom patch profile that contains the patches. This approach is always
preferable to creating a new custom patch profile and modifying start scripts so they
point to it. Avoid creating a new profile for each patch that you download. By keeping
the number of profiles you create to a minimum, you can more efficiently take
advantage of the patch validation and dependency checking capabilities built into
Smart Update and the My Oracle Support Repository.
In addition, when you minimize the number of custom profiles you use, you minimize
the number of start script modifications that you must maintain. As a result, the
likelihood of introducing errors in your scripts is reduced. In addition, the work
required to remove patches is simplified: you simply update the appropriate patch
profile; the need to update scripts is minimized.

6.2.3.2 Modifying Domain and Server Start Scripts
A start script provides a great deal of flexibility. The use of specific names and
locations for start scripts is not enforced. However, by staying within the default
directory structure that the Configuration Wizard creates for a domain, and by
retaining the location and structure of the start scripts that are provided, you maximize
your ability to rely on Smart Update to locate and generate suggested changes for start
scripts that are required when custom profiles are used.
In general, when pointing a domain or server at a custom patch profile, keep in mind
the following guidelines:
■
■

■

Before modifying a start script, make a backup copy.
Modify the start script at the most general level possible. For example, to point a
domain at a custom patch profile, modify the setDomainEnv script, rather than
each script that starts a server within the domain. When you implement this
practice, you minimize the number of start scripts that you need to modify and
maintain.
Never point a domain or server at more than one patch profile. Patch validation is
performed within the boundaries of a single patch profile; it is never performed
for multiple profiles simultaneously.
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6.2.3.3 Removing Patches That Affect Installation-Wide Resources
Generally, there are no restrictions on the set of patches that can be added to a custom
patch profile or removed from it. Patches that affect installation-wide resources,
however, are automatically placed in all existing patch profiles for a target installation.
If you remove a patch that affects installation-wide resources from any single patch
profile (regardless of whether that profile is the default profile or a custom profile), the
patch is automatically removed from all patch profiles. If you have multiple profiles in
a target installation, and you try to replace or remove a patch that affects
installation-wide resources, Smart Update displays a warning.

6.3 Creating a Custom Patch Profile
To create a custom patch profile, complete the steps in this section.
Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.
1.

In the Target Installation panel, select a product installation.

2.

Choose Patches > Patch Profiles > New.

3.

In the New Patch Profile dialog box, choose the following:
a.

A name for the custom patch profile

b.

The initial contents of the profile
When you create a custom patch profile, Smart Update creates
a directory for it, using the name you have chosen for the profile.
Therefore, to ensure that custom patch profiles can be used with any
combination of hardware and operating system supported by
products software, only alphanumeric characters may be used in
custom patch profile names.

Note:

4.

Click Create.

The following topics provide more information about custom profiles:
■

Section 6.3.1, "Initial Contents of a Custom Patch Profile"

■

Section 6.3.2, "Cloning a Patch Profile"

■

Section 6.3.3, "Adding Patches to a Custom Patch Profile"

■

Section 6.3.4, "Deleting a Custom Patch Profile"

6.3.1 Initial Contents of a Custom Patch Profile
Custom patch profiles may contain the following types of patches:
■
■

■

Classes that can be loaded in the WebLogic system classpath
Classes that can be loaded in the extended classpath, for applications deployed on
WebLogic Server
Native library files that can be added to the library path
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By default, any installation-wide patches that have been applied to the target
installation are automatically included whenever you create a new patch profile. Smart
Update gives you the option, however, of creating a patch profile that initially contains
no patches.
When you clone the contents of an existing patch profile to create a custom patch
profile, only a subset of the patches from the existing patch profile are physically
duplicated on disk:
■

Patch JAR files are not duplicated. A single patch JAR file is shared by all the patch
profiles on your system that reference them.
Replacement patches are not duplicated. When a patch replaces a system resource
at the time it is first applied, the system resource is not replaced each time the
patch is automatically duplicated in a custom patch profile, nor is a duplicate copy
made of the patch container that is referenced by a duplicate entry for the patch in
the custom patch profile.

■

Native library files from patches that are loaded into the system path at server
start time are duplicated in the installation-level patch directory. If disk space is a
concern, verify that the amount of space occupied by native library files that are
duplicated by a custom patch profile is not causing a problem.
Note: Patches that contain replacements for files or other artifacts are
automatically applied to the entire installation.

6.3.2 Cloning a Patch Profile
If you want to create a custom patch profile that includes the same patches in an
existing patch profile, you can clone the existing profile and then customize it as
needed, by adding or removing patches. This technique is convenient for creating
custom patch profiles quickly.
Patches that affect installation-wide resources are included in
all patch profiles created in a target installation. You cannot remove
this type of patch from one profile without removing it from all patch
profiles on the target installation. If you attempt to do so, Smart
Update displays a warning message.

Note:

6.3.3 Adding Patches to a Custom Patch Profile
After you create a custom patch profile, you can add or remove patches to it, just as
you added or removed patches from the default patch profile:
1.

From the Manage Patches tab, select the custom patch profile you have created.

2.

To add a patch to the profile, select the patch you want to add from the
Downloaded Patches panel, and click Apply.

3.

To remove a patch from the profile, select that patch from the list that is displayed
for the patch profile, and click Remove.

When you apply a patch to the target installation, the following events occur:
1.

The patch is validated against patches in the current patch profile.

2.

If there are no patch conflicts, the patch is applied.
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Though the patch may be validated and applied to the target
installation, any patch containing either classes to be loaded into a
classpath or native library files to be loaded into a library path does
not take effect until you complete the following steps:

Note:

■

■

Modify the appropriate domain or server start scripts, if necessary,
to point to the patch.
Restart the appropriate domains, servers, or applications. Shared
archive patches should be explicitly referenced by the application,
as described in Section 5.8, "Shared Archive Patches."

If conflicts are detected, the Patch Installation Validation dialog box displays a
summary of those conflicts. The patch cannot be applied until the conflicts are
resolved. For more information, see Section 4.4, "Resolving Patch Conflicts."
3.

When the patch is applied, it is added to the current patch profile. The patch is no
longer listed in the Downloaded Patches panel of the Manage Patches tab for this
profile.

6.3.4 Deleting a Custom Patch Profile
To delete a custom patch profile, complete the following steps:
1.

From the Manage Patches tab, select the custom patch profile you want to delete.

2.

Choose Patches > Patch Profiles > Delete.
A confirmation dialog box is displayed, giving you the option of continuing or
canceling the delete operation.

When deleting a custom patch profile, keep in mind that:
■

■

■

Any start script for a domain or server may fail if it points to a custom patch
profile that has been deleted. Instructions for pointing a domain or server at a
patch profile are provided in Section 6.4, "Pointing Domains and Servers at a
Custom Patch Profile."
When you delete a custom patch profile, the patches associated with it are not
removed.
You cannot delete the default patch profile. If you try to do so, Smart Update
displays an error message.

6.4 Pointing Domains and Servers at a Custom Patch Profile
To point a domain or server at a custom patch profile you have created, complete the
steps in this section.
Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.
1.

Make a backup copy of each script you plan to modify.

2.

In the Target Installation panel within Smart Update, select a target installation.
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3.

Choose the Patches > Start Script Editor menu option. The Start Script Editor
dialog box is displayed.

4.

In the Start Script Editor dialog box:
a.

Choose the custom patch profile to which the domain or server will point.

b.

Open the start script you want to modify. For instructions, see Section 5.4.3,
"Opening a Start Script"

c.

Add the patch path variables that reference your new custom patch profile.
Smart Update provides a code snippet containing suggested definitions for the
PATCH_CLASSPATH, WEBLOGIC_EXTENSION_DIRS, PATCH_LIBPATH, and
PATCH_PATH variables. These definitions reference patches that contain
classes and files to be inserted into the system class and library path. However,
depending on the content of the custom patch profile, and the specific patch
path variables you need to reference, you might need to make different
modifications.

d.

Save the start script.
When adding a definition of a patch path variable to a start
script, ensure that the definition appears before any statement that
invokes another start script. For example, if you add a patch path
variable definition to the setDomainEnv script, add it before the
statement that invokes the commEnv script. This placement ensures
that the definition you add is not overridden by a definition appearing
in any of the start scripts that are subsequently invoked.

Note:

The default start script for the WebLogic Server product home directory is WL_
HOME\common\bin\commEnv. It contains default values for the following variables
used for inserting patch files into a classpath or library path:
■

PATCH_CLASSPATH

■

WEBLOGIC_EXTENSION_DIRS

■

PATCH_LIBPATH

■

PATCH_PATH

For details, see Section 5.2.1.2, "Default Patch Path Environment Variables."
If you add definitions for these variables to a server or domain start script, your new
definitions override the default definitions, in the commEnv script, for the
corresponding servers or domain. Therefore, whenever you define these variables in a
server or domain script, ensure that your new definitions apply to the appropriate
server instances.
Also, note the order in which start scripts are executed: after the definition of one of
these variables has been set in a script, it is not overridden by any definition in a script
that is subsequently executed. For more information, see Section 5.2.1.4.1, "Sequence in
Which Start Scripts Are Executed."

6.4.1 Important Note if You Use Custom Scripts
If you use custom scripts in your environment that do not invoke the WL_
HOME\common\bin\commEnv script, you must change the statements in your scripts
that set the class and library paths for your environment so that the environment
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variables you have defined are properly inserted into statements such as Set
WEBLOGIC_CLASSPATH and Set PATH.
For example, to set the WebLogic system classpath so that patch JARs in a custom
patch profile supersede same-named classes appearing later in the classpath, add the
PATCH_CLASSPATH variable as follows, shown in bold:
set WEBLOGIC_CLASSPATH=%PATCH_CLASSPATH%;%JAVA_HOME%\lib\tools.jar;
%WL_HOME%\server\lib\weblogic_sp.jar;%WL_HOME%\server\lib\weblogic.jar;
%WL_HOME%\server\lib\webservices.jar

For more information about pointing custom scripts at patch profiles, see Section 5.5,
"Pointing All Domains and Servers at Patches Through Custom Scripts."

6.5 Managing Custom Patch Profiles in a Node Manager Environment
If you use the Node Manager in your domain, and all the patches used in your domain
are applied to the default patch profile, the servers started by the Node Manager run
against those patches automatically. If, however, you use custom patch profiles in a
domain that is configured to use the Node Manager, you must complete the additional
procedure provided in this section.
Note: Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

To ensure that all the Managed Servers in a domain cluster point to patches in the
custom patch profile at startup time, complete the following steps:
1.

Ensure that each Node Manager instance is the Java-based version that runs
within a Java Virtual Machine (JVM) process. To ensure that Node Manager is
restarted automatically whenever the system is restarted, it is recommended that
you run every Node Manager instance as follows:
■

On Windows platforms: as a Windows service

■

On UNIX platforms: as an operating service

Use of the script-based version of the Node Manager is not supported for the
procedures presented in this section.
2.

If the custom patch profile that must be referenced by the Managed Servers at start
time contains patch JAR files for the WebLogic system classpath, but it does not
contain native library files that need to be inserted into the system path, you can
set the classpath for the affected Managed Servers through the WebLogic Server
Administration Console, as follows:
a.

Start the Administration Server.

b.

Access the WebLogic Server Administration Console by entering the following
URL:
http://hostname:port/console

Here hostname represents the DNS name or IP address of the Administration
Server, and port represents the number of the port on which the
Administration Server is listening for requests (port 7001 by default).
c.

In the Change Center of the Administration Console, click Lock & Edit.
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3.

d.

In the left pane of the Console, expand Environment and select Servers.

e.

In the Servers table, click the name of each Managed Server you want to
configure. For each Managed Server, complete steps (f) and (g).

f.

Choose the Configuration > Server Start menu option.

g.

Add the PATCH_CLASSPATH environment variable to the beginning of the
Classpath field.

h.

Click Save.

i.

To activate these changes, in the Change Center of the Administration
Console, click Activate Changes.

If the custom patch profile that must be referenced by the Managed Servers at start
time contains native library files that need to be inserted into the system path,
regardless of whether the custom patch profile also contains patch JAR files, you
need to edit the Node Manager nodemanager.properties file on each system
that hosts a Managed Server in the cluster. Open each such
nodemanager.properties file and make the following changes:
a.

Set the StartScriptEnabled property to true, as in the following
example:
StartScriptEnabled=true

b.

Ensure that the StartScriptName property is set to the WebLogic Server
start script used for all server instances in the domain. The default start scripts
are operating system-specific:
Windows:
startWebLogic.cmd

UNIX:
startWebLogic.sh

For information about modifying the nodemanager.properties file, see
"Node Manager Configuration and Log Files" in Node Manager Administrator's
Guide for Oracle WebLogic Server.
c.

In a text editor, open the setDomainEnv script for the domain
(setDomainEnv.cmd on Windows, setDomainEnv.sh on UNIX) and
define one or more of the patch path environment variables described in
Table 6–1.

For each file or directory identified in Table 6–1 that is included in the
installation-level patch directory (MW_HOME\patch_wlsversion), add a
definition to the setDomainEnv script for the corresponding patch path variable
so that the variable points to that file or directory. In Table 6–1, custom-profile
represents the name of the custom patch profile created in the installation-level
patch directory.
For example, if your system hosts a JAR file called MW_HOME\patch_
wls1000\profiles\custom-profile\sys_manifest_
classpath\weblogic_patch.jar, add a definition of the PATCH_CLASSPATH
variable to the setDomainEnv script that points to that file.
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Table 6–1

Patch Variables to Define in setDomainEnv for Node Manager Environments

Define the following
variable

If the following is present in the custom profile directory

PATCH_CLASSPATH

File:
MW_HOME\patch_wls103\profiles\custom-profile\
sys_manifest_classpath\weblogic_patch.jar
Purpose of variable:
The PATCH_CLASSPATH variable points to classes in patch JAR files
that are to be inserted into the WebLogic system classpath used by
each Managed Server that is started by the Node Manager in your
domain.
Example:
PATCH_CLASSPATH= "%MW_HOME%\patch_wls103\profiles\
myCustomProfile\sys_manifest_classpath \weblogic_patch.jar"
Note: The majority of patches issued by My Oracle Support are
referenced by this patch manifest JAR file.

WEBLOGIC_
EXTENSION_DIRS

File:
MW_HOME\patch_wls103\profiles\custom-profile\
sysext_manifest_classpath\weblogic_ext_patch.jar
Purpose of variable:
The WEBLOGIC_EXTENSION_DIRS variable points to classes in patch
JAR files that are to be inserted into the classpath of an application
that is deployed on WebLogic Server and required by a product.
Example:
WEBLOGIC_EXTENSION_DIRS="%MW_HOME%\
patch_wls103\profiles\myCustomProfile\
sysext_manifest_classpath\weblogic_patch.jar"
Note: Patch manifest JAR files that reference application-level classes
are not supported by WebLogic Server 9.1.

PATCH_LIBPATH

Directory (UNIX only):
MW_HOME/patch_wls103/profiles/custom-profile/native
Purpose of variable:
The PATCH_LIBPATH variable points to native library files to be
inserted into the system path through the LIBPATH environment
variable.
Example:
PATCH_LIBPATH="${MW_HOME}/patch_wls103/
profiles/myCustomProfile/native"

PATCH_PATH

Directory (Windows only):
MW_HOME\patch_wls103\profiles\custom-profile\native
Purpose of variable:
The PATCH_PATH variable points to native library files to be inserted
into the system path through the PATH environment variable.
Example:
set PATCH_PATH=%MW_HOME%\patch_wls103\
profiles\myCustomProfile\native
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4.

Restart the each Managed Server instance. Until you do so, your updates to the
Node Manager configuration files and patch path variable definitions do not
become effective
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At times you may want to uninstall a patch or patches. You can use Smart Update to
revert your system installation by removing patches that you have installed:
■

Section 7.1, "Important Note about Uninstalling Products"

■

Section 7.2, "Removing a Patch"

■

Section 7.3, "Uninstalling a Service Pack, Maintenance Pack, or Upgrade"

7.1 Important Note about Uninstalling Products
When you uninstall a product, any patches that may have been applied to that product
are not removed. This consideration is important if patches for multiple products in a
given Middleware home directory are applied to the same patch profile, and you
uninstall one product but continue to use the others. When this situation occurs,
products that you continue using run with patches for the product that has been
uninstalled.

7.2 Removing a Patch
Smart Update makes it easy to remove a patch that has been applied to a patch profile.
Installation-scoped shared archive patches cannot be removed
from a custom profile: they can only be removed in the default profile.
In this case, similar to the installation, the patch is removed from the
default profile and all custom profiles to which it was initially applied.

Note:

7.2.1 Removing a patch or patch set
To remove a patch or patch set, complete the following steps:
1.

Start Smart Update.

2.

In the Target Installation pane, select the product installation hosting the patch
you want to remove.

3.

Select the Manage Patches tab.

4.

Select the patch profile containing the patch or patch set you want to remove.

5.

Click the Remove button with the down arrow, located to the right of the patch or
patch set that you want to remove.

6.

In the Remove Patch from Profile dialog box, click OK.
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A validation dialog box is displayed. If you are removing one patch on which
another depends, a removal conflict is reported, which you must resolve before
proceeding. For information about resolving patch removal conflicts, see
Section 4.4.2, "Validation When Removing Patches." The patch removal progress is
tracked in the status window. A message is displayed when the removal is
complete.
7.

Shut down any running WebLogic Server instances, and restart them for the patch
removal to take effect.
If you remove a patch that belongs to a patch set, the entry for
the patch set is removed from the listing of the patch profile contents
from the Downloaded Patches panel. However, other member
patches of the set that have not been removed continue to be listed in
those locations.

Note:

7.3 Uninstalling a Service Pack, Maintenance Pack, or Upgrade
You can use Smart Update only to remove individual patches. You cannot use Smart
Update to remove a service pack, maintenance pack, or version upgrade that was
installed using an Upgrade installer. To remove such upgrades, use the WebLogic
Server uninstall program. See "Uninstalling the Software" in the Installation Guide for
Oracle WebLogic Server.
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This section describes the Smart Update bsu command, which you can use to apply
patches, interactively or through a script, that have been downloaded into a patch
download directory. When you use bsu commands in a script, you can create a
mechanism for replicating a specific maintenance level of a product that is installed on
multiple systems. This capability is especially valuable in production environments, in
which the distribution of software updates to systems must be implemented in a
controlled, reliable, and reproducible manner.
The following topics are included:
■

Section 8.1, "About the bsu Command"

■

Section 8.2, "bsu Command Reference"

■

Section 8.3, "Command-Line Interface Examples"

8.1 About the bsu Command
When using the bsu command, either interactively or through a script, note that this
command:
■

Runs the bsu script (bsu.cmd on Windows systems, bsu.sh on UNIX systems)
that is located in the MW_HOME\utils\bsu directory. When running the bsu
command, first change to this directory on the system from which you are running
it.

■

Can be executed from a command file (on Windows) or shell script (on UNIX).

■

Contains the subset of Smart Update functionality that enables you to:
–

Apply and remove patches that are located in an accessible patch download
directory

–

View patches that are in the download directory, applied to a product
installation on the current system, or applied to a specific patch profile for the
current system

–

Generate reports listing the patches applied to a product installation

The bsu command can also invoke the Smart Update graphical interface and send
messages to a log file.
■

Can apply patches to, or view patches on, only those products installed from the
system on which this command is run, as follows:
–

If the current system contains a product that was installed by a different
system, you cannot apply patches to that installation or view them.
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–

If the current system was used to install a product located on a
remote-mounted disk drive, you can use the bsu command with that
installation.

Therefore, the restrictions regarding the specific product installations that can be
maintained through the bsu command is the same as for Smart Update's graphical
interface.
■

Cannot be used for the following:
–

Creating custom patch profiles

–

Locating start scripts to modify

These capabilities are available only from Smart Update's graphical interface.
If you run the Smart Update command-line interface
simultaneously with the graphical interface, changes you make to
patch profiles through the command-line interface are not visible from
the graphical interface when you refresh the view of those patch
profiles.

Note:

8.2 bsu Command Reference
This section describes the bsu command syntax. Square brackets appearing with a
parameter argument indicate that the argument is optional.
The bsu command has the parameters and arguments listed and described in
Table 8–1.
Note: In Table 8–1, the square brackets, [..], represent arguments
that are optional. For example, [-profile=profile_name] is an
optional argument for the -install parameter

Table 8–1

bsu Command Parameters and Arguments

Parameter

Description

Arguments

-help

Displays a summary of bsu None.
parameters and arguments
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Table 8–1 (Cont.) bsu Command Parameters and Arguments
Parameter

Description

Arguments

-install

Applies specified patches
to the target installation.
You must specify a valid
profile name.

[-patchlist=patch1[,patch2,patch3]
Specifies the identifier of each patch to be applied,
represented as patch1, patch2, and patch3.
[-profile=profile_name]
Specifies the patch profile to which the patches are
to be applied, represented as profile_name.
See the note at the end of the table.
[-patch_download_dir=path]
Specifies the patch download directory from which
the patches are to be applied, represented as path.
If you do not specify a patch download directory,
the patch download directory designated in the
Preference dialog box in the Smart Update
graphical interface is used by default. (If none is
designated in the Preference dialog box, MW_
HOME\utils\bsu\cache_dir is used.)
[-verbose]
Displays the full set of details associated with each
patch applied.
[-prod_dir=path]
Specifies the target installation to which the
patches are to be applied, represented as path. For
example, MW_HOME\wlserver_10.3 for
WebLogic Server and Portal.

-gui

Starts the Smart Update
graphical interface.

None.

-log

Creates a file, in the
specified location, in which
the corresponding bsu
command logging
information is to be sent.

=path

Note: The -log parameter
logs only bsu command
activity, and not activity
related to patches or
profiles.
-remove

Removes specified patches
from the profile.

Specifies the file name and location of the log file
to be created, represented as path.
[-log_priority=
{trace|debug|info|warn|error|fatal}]
Specifies the priority of log information to be
captured. The default priority is debug.

[-patchlist=patch1[,patch2,patch3]
Specifies the identifier of each patch to be applied,
represented as patch1[,patch2, and patch3.
[-profile=profile_name]
Specifies the patch profile from which the patches
are to be removed, represented as profile_name. See
the note at the end of the table.
[-prod_dir=path]
Specifies the target installation from which the
patches are to be removed, represented as path.
[-verbose]
Displays the full set of details associated with each
patch applied.
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Table 8–1 (Cont.) bsu Command Parameters and Arguments
Parameter

Description

Arguments

-report

Generates a report showing
the applied patches and
associated file changes in a
Middleware home
directory.

-BEA_HOME=path
Specifies the target installation where the patches
are applied, represented as path. If no path is
specified, this option generates report for all
product installations. Specify the appropriate
Middleware home directory.
[-product_mask=regexp]
Limits the report to the matching product(s),
represented by the regular expression regexp.
Note: The regular expression is used to delimit
multiple arguments. For example, -product_
mask=WebLogic.* filters all products starting
with WebLogic.
[-release_mask=regexp]
Limits the report to the matching product
release(s), represented by the regular expression
regexp.
[-profile_mask=regexp]
Limits the report to the matching patch profile(s),
represented by the regular expression regexp.
[-patch_id_mask=regexp]
Limits the report to the matching patch(es),
represented by the regular expression regexp.
[-output_format=text|xml]
Specifies the format of the report. Options
available are text and xml. Default: text.
[-output_file=path]
Specifies the directory where the report is saved,
represented as path. If no path is specified for the
report output, stdout is used.

-version

Displays version
information.

None.

For example:
Oracle Smart Update.
Version: 3.3.3.0
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Table 8–1 (Cont.) bsu Command Parameters and Arguments
Parameter

Description

Arguments

-view

Displays the identifiers of
patches that are either
applied or in the patch
download directory

[-profile=profile_name]
Displays identifiers of patches applied to the
profile represented as profile_name. If you do not
specify this argument, the default patch profile is
used by default.
See the note at the end of the table.
[-patch_download_dir=path]
Displays the identifiers of patches that have been
downloaded into the patch download directory
represented as path. If you do not specify a patch
download directory, the patch download directory
designated in the Preference dialog box is used by
default. (If none is designated in the Preference
dialog box, MW_HOME\utils\bsu\cache_dir is
used.)
[-status={applied|downloaded}
Displays the current status of the patches viewed.
If you specify applied for this argument, bsu
displays identifiers of patches that have been
applied to the target installation. Use this
argument, with -profile, to create a
maintenance snapshot for the specific profile. If
you specify downloaded, bsu displays identifiers
of patches in the download directory but not yet
applied
.[-verbose]
Displays the full set of details associated with each
patch displayed.
-prod_dir=path
Displays the identifiers of patches applied to the
target installation in the location represented as
path.

Note:

If profile is not specified, the Default profile is used.

If the profile argument is used and an invalid profile is specified, it
is not set to default; it displays the error:
$ bsu -view -status=applied -prod_dir=C:/10_WLP/wlserver_
version-profile=profile3
The specified profile could not be found.[profile_name]

8.3 Command-Line Interface Examples
This section includes the following bsu command examples:
■

Section 8.3.1, "Installation Example"

■

Section 8.3.2, "View Patches Example"

■

Section 8.3.3, "Another View Patches Example"

■

Section 8.3.4, "Display Maintenance Snapshot"

■

Section 8.3.5, "Report of Applied Patches"

Using the Command-Line Interface 8-5

Command-Line Interface Examples

8.3.1 Installation Example
The following command installs the patch IRZ2 from the patch download directory
that has been established for the current system:
bsu -prod_dir=c:\Oracle\Middleware\wlserver_10.3 -patchlist=IRZ2 -verbose -install

When executed, the preceding command displays the following output showing that
the patch was successfully applied:
Checking for conflicts.
No conflict(s) detected
Starting installation of Patch ID: IRZ2
Installing C:\Oracle\Middleware\download-dir\IRZ2.jar
Result: Success

8.3.2 View Patches Example
The following command displays a list of patches that exist in the patch download
directory, c:\patchdir:
bsu -view -status=downloaded -prod_dir=C:\Oracle\Middleware\wlserver_10.3
-patch_download_dir=C:\patchdir

When executed, the preceding command generates a display similar to the following:
C:\Oracle\Middleware\utils\bsu>bsu -view -status=downloaded
-prod_dir=C:\Oracle\Middleware\wlserver_10.3 –patch_download_dir=C:\patchdir
ProductName:
WebLogic Platform
ProductVersion: 10.3
Components:
WebLogic Platform/WebLogic Server,WebLogic Platform/Workshop
for WebLogic Platform,WebLogic Platform/WebLogic Portal
BEA_HOME:
C:\Oracle\Middleware
ProductHome:
C:\Oracle\Middleware\wlserver_10.3
PatchSystemDir: C:\Oracle\Middleware\utils\bsu
PatchDir:
C:\Oracle\Middleware\patch_wls_1032
Profile:
Default
DownloadDir:
C:\patchdir
JavaHome:
C:\Oracle\Middleware\jrockit160_14_R27.6.5-32
JavaVersion:
160_14_R27.6.5-32
JavaVendor:
ORACLE
Patch ID:
9A5T (10131320)
Patch ID:
585H (10201173)
Patch ID:
8LU6 (10106400)
Patch ID:
AFJ5 (10111681)
Patch ID:
Q8K5 (10085296)

8.3.3 Another View Patches Example
The following command displays the set of patches for a target installation that have
been downloaded to the system's designated patch download directory:
bsu -view -prod_dir=C:\Oracle\Middleware\wlserver_10.3 -status=downloaded -verbose

When executed, the preceding command generates a display similar to the following:
ProductName:
WebLogic Platform
ProductVersion:
10.3
Components:
WebLogic Server/Server,WebLogic Server/Server Examples,
AquaLogic Service Bus/Service Bus
BEA_HOME:
C:\Oracle\Middleware
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ProductHome:
DownloadDir:
JavaHome:
JavaVersion:
JavaVendor:
Patch ID:
PatchContainer:
Checksum:
Component:
Severity:
Category:
CR:
Restart:
Description:
Patch ID:
PatchContainer:
Checksum:
Component:
Severity:
Category:
CR:
Restart:
Description:

C:\Oracle\Middleware\wlserver_10.3
C:\Oracle\Middleware\download-dir
C:\Oracle\Middleware\jrockit160_14_R27.6.5-32
160_14_R27.6.5-32
ORACLE
FZN2
FZN2.jar
-174938558
WebLogic Server
critical
Security
CRxxyyzz
false
ATN fix for xxxx
GWQR
GWQR.jar
1170817068
AquaLogic Service Bus
optional
Multiple
CRxxyyzz
true
One more ALSB patch

8.3.4 Display Maintenance Snapshot
The following command displays a maintenance snapshot of the default patch profile:
bsu -view -status=applied -prod_dir=c:\BEA\wlserver_10.0

When executed, the preceding command generates a display similar to the following:
C:\Oracle\Middleware\utils\bsu>bsu -view -status=applied
-prod_dir=C:\Oracle\Middleware\wlserver_10.0
ProductName:
WebLogic Server
ProductVersion:
10.0
Components:
WebLogic Server/Server,WebLogic Server/Server Examples,
WebLogic Server/Server
BEA_HOME:
C:\Oracle\Middleware
ProductHome:
C:\Oracle\Middleware\wlserver_10.0
PatchSystemDir:
C:\Oracle\Middleware\utils\bsu
PatchDir:
C:\Oracle\Middleware\patch_wls1000
Profile:
Default
DownloadDir:
C:\Oracle\Middleware\utils\bsu\cache_dir
JavaHome:
c:\Oracle\Middleware\jdk150_06
JavaVersion:
1.5.0_06
JavaVendor:
Sun
Patch ID:
PBLW (CR838734)
ProductName:
ProductVersion:
Components:

WebLogic Portal
10.0
WebLogic Portal/Portal Server,WebLogic Portal/WebLogic Works
WebLogic Portal/Portal Examples
BEA_HOME:
C:\Oracle\Middleware
ProductHome:
C:\Oracle\Middleware\wlserver_10.0
PatchSystemDir:
C:\Oracle\Middleware\utils\bsu
PatchDir:
C:\Oracle\Middleware\patch_wlp1000
Profile:
Default
DownloadDir:
C:\Oracle\Middleware\utils\bsu\cache_dir
Patch ID:
FJTH (CR861234)
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C:\Oracle\Middleware\utils\bsu>
C:\Oracle\Middleware\utils\bsu>bsu -view -status=applied -prod_dir=C:\10_WLP_0
320\workshop_10.0
ProductName:
Workshop for WebLogic
ProductVersion:
10.0
Components:
Workshop for WebLogic Platform/Workshop,Workshop for WebLogic
Platform/Workshop Examples
BEA_HOME:
C:\Oracle\Middleware
ProductHome:
C:\Oracle\Middleware\workshop_10.0
PatchSystemDir:
C:\Oracle\Middleware\utils\bsu
PatchDir:
C:\Oracle\Middleware\patch_wlw1000
Profile:
Default
DownloadDir:
C:\Oracle\Middleware\utils\bsu\cache_dir
Patch ID:
8K9T (CR873456)

8.3.5 Report of Applied Patches
The following command generates a report of patches applied to an MW_HOME,
where the first character of the patch IDs is "6":
bsu -report -patch_id_mask=6.*

When executed, the preceding command generates a display similar to the following:
Patch Report
============
Report Info
Report Option
BEA_HOME ### OPTION NOT SET
product_mask.. ### OPTION NOT SET
release_mask.. ### OPTION NOT SET
profile_mask.. ### OPTION NOT SET
patch_id_mask. 6.*
Report Messages
BEA_HOME D:\Platform92\BEA_HOME
Product Description
Product Name.. WebLogic Platform
Product Version.. 9.2.0.0
Installed Components WebLogic Server, Workshop for WebLogic Platform,
WebLogic Integration, WebLogic Portal
Product Install Directory. D:\Platform92\BEA_HOME\weblogic92
Java Home.. D:\Platform92\BEA_HOME\jrockit90_150_04
Jave Vendor BEA
Java Version.. 1.5.0_04
Patch Directory.. D:\Platform92\BEA_HOME\patch_weblogic920
Profile. Default
Patch ID 6L1H
CR(s) CR285988
Description Fix P13N processing of Platform Domain Upgrade.
Intended for use with WLI 9.2
Classpath
Classpath type SYSTEM
Classpath control jar.. weblogic_patch.jar
Jar.. CR285988_920.jar
File.com/BEA/p13n/upgrade/LibraryModuleConfigProcessor.class
File. com/BEA/p13n/upgrade/P13nDatabasePlugIn.class
File. resources/p13n-upgrade.xml
File. resources/P13nCommonPlugIn-definition.xml
File. resources/portal-upgrade.xml
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File. META-INF/MANIFEST.MF
Patch ID 6MK8
CR(s) CR262488
Description Allow WLI Domains to be upgraded by Domain Upgrade Wizard
Classpath
Classpath type SYSTEM
Classpath control jar.. weblogic_patch.jar
Jar.. CR262488_920.jar
File.weblogic/upgrade/domain/directoryselection/DomainDirectorySelectionPlugIn.cla
ss
File.weblogic/upgrade/domain/directoryselection/i18n_
DomainDirectorySelectionPlugIn.properties
File. META-INF/MANIFEST.MF
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This section provides the following topics:
■
■

Section 9.1, "Distributing Patches to a Production Environment"
Section 9.2, "Providing Patches to Systems that Cannot Connect to My Oracle
Support"

9.1 Distributing Patches to a Production Environment
This section discusses the following models for distributing patches to a production
environment:
■

■

Section 9.1.1, "Using Smart Update Scripts to Promote a Standard Maintenance
Level to a Production Environment"
Section 9.1.2, "Creating and Distributing an Archive of the Product Installation"

These models assume the following about the software maintenance that is provided
for systems in the production environment:
■

■

■

■

Patches obtained from a vendor are tightly controlled and managed. For example,
they might be kept in a secure repository that few individuals are authorized to
access. Copying or downloading patches into the repository might be subject to
rigorous approval, scheduling, auditing, and logging procedures.
Patches are promoted to production systems in specific stages during which they
are thoroughly tested. For example, a patch might first be installed on a single
system, separated from the production environment, in which production
applications are tested to ensure that the patch works as expected and does not
introduce regressions. Before being rolled out into the production environment,
the patches may be tested in an intermediate staging area, where it is subject to
loads that mimic expected usage in the production environment.
When a patch is introduced into the production environment itself, all systems on
which the patch is installed must run the updated product software at precisely
the same maintenance level. For example, the domain configuration, product
version, and patch level of WebLogic Server 9.1 used in all systems is identical.
Systems in the production environment may not obtain patches from the Internet.
In fact, the systems may not be connected to the Internet at all, and possibly not to
the same Local Area Network shared by systems that have an Internet connection.
Instead, patches are made available only from a specific location, or set of
locations, in the enterprise, and downloading of patches to the production systems
are regulated by several business practices and procedures.
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■

The WebLogic Server instances used in the production environment are started by
highly customized scripts.

9.1.1 Using Smart Update Scripts to Promote a Standard Maintenance Level to a
Production Environment
This section describes an example scenario of how the features in Smart Update can be
leveraged to distribute patches to production systems that are subject to some or all of
the conditions described in the preceding paragraphs.
1.

My Oracle Support has provided a patch to solve a problem that Avitek has
reported with its enterprise applications that run on WebLogic Server 9.1.

2.

Bob Jones, in the Avitek IT department, downloads the patch into the patch
download directory for his system, which is set to a network disk used by IT to
store maintenance updates provided by all of Avitek's software vendors.

3.

Rachel Burns works in Avitek's QA department, and her job is to test the patch on
her system, which also has a WebLogic Server installation identical to the one used
in the production environment. The domain configuration on Rachel's system is
similar to the WebLogic domains running in Avitek's production environment.
Rachel created the WebLogic Server start scripts used in the production
environment, which also run on her system.
Rachel runs Smart Update in offline mode. She makes sure that the patch
download directory is set to the directory used by Bob, and then she applies the
patch to her WebLogic Server installation.

4.

Rachel realizes that because the production systems use customized WebLogic
Server start scripts, the scripts must be modified so that the classes contained in
the patch are loaded into the WebLogic system classpath on her system.
Rachel adds a definition of the PATCH_CLASSPATH variable to the start script so
that it points to the default patch profile, then she adds this variable to the
beginning of the SET WEBLOGIC_CLASSPATH statement.

5.

Rachel successfully tests the patch, and is ready to replicate the patch throughout
the 20 product installations that run in Avitek's production environment. Because
each production system is nearly identical, Rachel knows that she can create a
script that works on every system to apply the patch.
She creates the script. Its function is very simple: it applies the patch to the default
patch profile for the target installation, and it copies an updated start script into
the proper location of each system.

6.

Rachel uploads the patch to a patch download directory kept on a secure disk that
is used by the production systems in Avitek's DMZ. She also uploads the Smart
Update script and new WebLogic Server start script onto the secure disk.

7.

Dagmar Kohl administers the systems in Avitek's production environment. She
downloads the Smart Update script onto each production system and runs it.

8.

Because of the patch contents, Dagmar knows that each server must be restarted
for the patch to take effect. When the servers are restarted, the maintenance
procedure is complete.

9.1.2 Creating and Distributing an Archive of the Product Installation
As an alternative to the scenario described in Section 9.1.1, "Using Smart Update
Scripts to Promote a Standard Maintenance Level to a Production Environment," you
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can create an archive of a fully patched product image, and replicate that image
throughout all the systems in a production environment. If you take this approach,
note the following caveats:
■

■

This approach is not recommended. Oracle always recommends the use of product
installers for creating a product installation on a system, and of Smart Update to
distribute patches.
If a product installation includes maintenance patches that have been applied
using Smart Update, you must include the following directories in the archive
image, which exist at the top level of the Middleware home directory:
–

patch_version, and all subdirectories

–

utils, and all subdirectories

9.2 Providing Patches to Systems that Cannot Connect to My Oracle
Support
As mentioned in Section 1.7.2, "Maintaining Machines That Do Not Have Access to My
Oracle Support," Smart Update's offline usage mode enables you to install
maintenance updates on systems from which it is not possible to connect to My Oracle
Support. This section describes the following methods you can use for providing
patches to these systems:
■

Section 9.2.1, "Patching an Offline System Through a Shared Patch Download
Directory"

■

Section 9.2.2, "Patching an Offline System Through Removable Media"

■

Section 9.2.3, "Additional Means for Patching an Offline System"

For the purposes of describing these techniques in these sections, a system that cannot
connect to My Oracle Support is called an offline system.

9.2.1 Patching an Offline System Through a Shared Patch Download Directory
The following topics explain how to patch an offline system through a shared patch
download directory:
■

Section 9.2.1.1, "Requirements"

■

Section 9.2.1.2, "Steps"

9.2.1.1 Requirements
Installing patches on an offline system through a shared patch download directory has
the following two primary requirements:
■

■

A system that can establish a connection to My Oracle Support and that has the
following:
–

A local installation of a product that matches the product and version of the
product installed on the offline system

–

A My Oracle Support user account

A networked disk that can be accessed by both the system that can connect to My
Oracle Support and the offline system
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9.2.1.2 Steps
To patch a disconnected system remotely from the system with Internet access,
complete the following steps using the system that has Internet access:
1.

From the system that can connect to My Oracle Support, log in to My Oracle
Support and download the desired patch or patches to the directory from which
you will apply the patches. See Chapter 2, "Downloading Patches."

2.

Start Smart Update and complete the following steps:

3.

a.

Choose File > Preferences, and specify the location to which you downloaded
the patches in step 1.

b.

If you downloaded a publicly available patch, choose the product installation
in the Target Installation panel that matches the product and version of the
software installed on the offline system.

From the offline system:
a.

Start Smart Update.

b.

Choose File > Preferences, and set the patch download directory to the
location into which the patches were downloaded by the system that
connected to My Oracle Support.

c.

In the Target Installation panel, choose the target installation to which you
want to apply the patches.

d.

On the Manage Patches tab, ensure that the appropriate patch profile is
selected.

e.

In the Downloaded Patches panel, click Apply next to the patches you want
to apply.

f.

Complete the procedure for applying patches, as described in Section 4.3,
"Applying and Managing Patches."

9.2.2 Patching an Offline System Through Removable Media
The following topics explain how to patch an offline system through removable media:
■

Section 9.2.2.1, "Requirements"

■

Section 9.2.2.2, "Steps"

9.2.2.1 Requirements
Installing patches on an offline system using removable media has the following two
primary requirements:
■

■

A system that can establish a connection to My Oracle Support and that has the
following:
–

A local installation of a product that matches the product and version of the
product installed on the offline system

–

A My Oracle Support user account

The ability to place patches onto a type of removable media that can be used by
both the system connected to Oracle Support and the offline system. For example:
a writable CD-ROM or DVD.
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9.2.2.2 Steps
To apply patches to an offline system using removable media, complete the following
steps.
1.

From the system that can connect to My Oracle Support, log in to My Oracle
Support and download the desired patch or patches to the directory from which
you will copy the patches to removable media. See Chapter 2, "Downloading
Patches."

2.

Start Smart Update and complete the following steps:

3.

a.

Choose File > Preferences, and specify the location to which you downloaded
the patches in step 1.

b.

If you downloaded a publicly available patch, choose the product installation
in the Target Installation panel that matches the product and version of the
Oracle software installed on the offline system.

c.

Copy the downloaded patches onto the removable media.

From the offline system:
a.

Mount the removable media onto the offline system.

b.

Start Smart Update

c.

Choose File > Preferences and set the patch download directory as the
directory for the removable media that contains the patches.

d.

In the Target Installation panel, select the target installation to be patched.

e.

On the Manage Patches tab, select the appropriate patch profile.

f.

From the Downloaded Patches panel, click Apply next to each patch that you
want to apply.

g.

Complete the procedure for applying patches, as described in Section 4.3,
"Applying and Managing Patches."

9.2.3 Additional Means for Patching an Offline System
My Oracle Support may provide you with alternative means, as appropriate, for
providing you with patches if you are unable to make an online connection to My
Oracle Support.
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This section lists the limitations that have been identified in Oracle Smart Update.
Wherever possible, workarounds are provided.

10.1 General Issues and Workarounds
This section describes the following general issues and workarounds associated with
Oracle Smart Update.
■

■
■

■

■

■

■

■

■

■

Section 10.1.1, "Smart Update 3.1 Exits with an Error if Version Strings of Products
that are Not Supported by Smart Update are Present in the Registry"
Section 10.1.2, "Smart Update Does Not Run on Apple Macintosh Machine"
Section 10.1.3, "Exceptions are Thrown When You Use Smart Update with Node
Manager Running"
Section 10.1.4, "Patch Application Does Not Enforce Product Check in
Command-line Mode"
Section 10.1.5, "Invalidated Patches List Other Invalidated Patches as Their
Replacement"
Section 10.1.6, "The Patch Profile Maintenance Snapshot Is Poorly Formatted
When Viewed in Notepad"
Section 10.1.7, "Smart Update Graphical User Interface Displays an Exception in
Rare Cases"
Section 10.1.8, "Uninstall Component Does Not Remove Component Patches
Automatically"
Section 10.1.9, "GUI Cannot Refresh Patches Installed from Command Line
Without Restart"
Section 10.1.10, "Issues with Domains Created After Rollback from WebLogic
Server 10.3.2 to 10.3.1"

10.1.1 Smart Update 3.1 Exits with an Error if Version Strings of Products that are Not
Supported by Smart Update are Present in the Registry
Smart Update 3.1 exits with an error if version strings of products that are not
supported by Smart Update (such as Oracle Tuxedo) exist in the registry, and if the
unsupported products and WebLogic Server are in the same Middleware home.
This error occurs, for example, when you run Smart Update on a machine that has
PeopleSoft, which is dependent on Oracle Tuxedo – an product that Smart Update
does not support.
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To work around this issue, upgrade to Smart Update 3.2.1, which ignores version
strings of unsupported products.
You can upgrade to Smart Update 3.2.1 by performing the following steps:
1.

Rename the beahomelist file to beahomelist_.
For Windows, the beahomelist file is located under the ${SystemDrive}\bea
folder.
For Linux and UNIX, the beahomelist file is located under the ${HOME}\bea
folder.

2.

Invoke Smart Update.
Smart Update downloads the new version of the tool and upgrades itself
automatically.

3.

Close Smart Update.

4.

Rename the beahomelist_ file back to beahomelist.

10.1.2 Smart Update Does Not Run on Apple Macintosh Machine
You cannot run Smart Update on a Macintosh machine because enough heap memory
is not allocated by default.
To work around this issue, increase the Java heap memory by modifying the bsu.sh
script in the MW_HOME/utils/bsu folder.
The following code illustrates the line in the script you must edit to increase the heap
memory. The edited value is in bold text.
"$JAVA_HOME/bin/java" -Xms64m -Xmx256m -jar patch-client.jar $*

10.1.3 Exceptions are Thrown When You Use Smart Update with Node Manager
Running
This issue applies only to MS Windows platforms.
Exception com.bea.plateng.patch.PatchInstallationException is thrown
when you apply or remove patch using Smart Update or during an incremental
installation to a Middleware home with Node Manager running.
When Node Manager is running, the process locks the file weblogic_patch.jar. As
a result, the patch cannot be installed or removed successfully because it fails to
update weblogic_patch.jar.
To work around this issue, shut down Node Manager when you perform incremental
installation or invoke Smart Update from the same Middleware home.

10.1.4 Patch Application Does Not Enforce Product Check in Command-line Mode
If you have installed WebLogic Integration in command-line mode, and opted to apply
patches automatically (by selecting option 1) after successful completion of the
installation, the installer automatically applies patches to WebLogic Server, Workshop
for WebLogic, and WebLogic Portal. The installer does not check whether WebLogic
Portal is installed or not; the patches to WebLogic Portal are applied even when
WebLogic Portal is not installed.
If WebLogic Portal is installed at a later point, the installer overwrites the patches but
Smart Update shows the patches as applied.
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To work around this issue, uninstall the patches, then install WebLogic Portal, and
then apply the WebLogic Portal patches using Smart Update.

10.1.5 Invalidated Patches List Other Invalidated Patches as Their Replacement
When you display details about an invalidated patch, the ID of the replacement patch
may be provided. But if the replacement patch is subsequently invalidated by My
Oracle Support, this ID is not updated and refers to an invalidated patch.
Contact My Oracle Support for a workaround for this issue.

10.1.6 The Patch Profile Maintenance Snapshot Is Poorly Formatted When Viewed in
Notepad
The patch profile maintenance snapshot file produced by Smart Update cannot be
easily viewed in common text editors, such as Notepad. The snapshot file does not
contain conventional line breaks, which results in poorly formatted columns that
cannot be easily read.
To work around this issue, use a text editor such as WordPad or TextPad to view this
file. You do not need to reformat this file when sending it to My Oracle Support.

10.1.7 Smart Update Graphical User Interface Displays an Exception in Rare Cases
In rare cases, when using the Smart Update graphical interface, the following
exception may be displayed:
java.util.ConcurrentModificationException
at
java.util.TreeMap$PrivateEntryIterator.nextEntry(TreeMap.java:1031)
at java.util.TreeMap$KeyIterator.next(TreeMap.java:1058)
at
com.bea.plateng.patch.gui.PatchStoreTableModel.getRowCount(PatchStoreTableModel.ja
va:199)

This exception can be ignored.

10.1.8 Uninstall Component Does Not Remove Component Patches Automatically
If you uninstall any component, the patches associated with that component are not
removed automatically. The patched artifacts may have been removed as part of the
uninstallation, but the patch is still shown as applied.
To work around this issue, use Smart Update to remove the patches associated with
the component before uninstallation.

10.1.9 GUI Cannot Refresh Patches Installed from Command Line Without Restart
If you use the Smart Update graphical and command-line interfaces simultaneously,
patches that you apply through the command-line interface are not visible from the
GUI when you refresh the view.
To work around this issue, exit and restart the Smart Update GUI to view the new
patch.
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10.1.10 Issues with Domains Created After Rollback from WebLogic Server 10.3.2 to
10.3.1
After performing an upgrade from WebLogic Server 10.3.1 to WebLogic Server 10.3.2
using an upgrade installer, if you roll back to the 10.3.1 release (using the WebLogic
Server uninstaller Rollback option), the following issues occur:
■
■

WebLogic Server starts, but validation errors occur
the Administration Console cannot be accessed (a 500 Error is displayed in the
browser)

Note that these issues do not occur when upgrading from 10.3.0 to 10.3.2, and rolling
back to 10.3.0.
Workaround
The only known workaround is to restore the original WebLogic Server 10.3.1
installation, if it is backed up.

10-4 Smart Update Applying Patches to Oracle WebLogic Server

11
Frequently Asked Questions

11

This FAQ includes the following questions:
■

Section 11.1, "How do I get a Support ID?"

■

Section 11.2, "What is a Bug or CR?"

■

Section 11.3, "How can I get a fix to a bug? Can I get a patch for a bug?"

■

Section 11.4, "How do I obtain security advisory notifications?"

■

Section 11.5, "What is a private patch?"

■

Section 11.6, "How do I download just a maintenance pack?"

■

Section 11.7, "What products can I patch using the Smart Update tool?"

■

Section 11.8, "Do I need a support contract to download patches from My Oracle
Support?"

11.1 How do I get a Support ID?
To obtain a My Oracle Support account, go to the Oracle Support site,
http://www.oracle.com/support/index.html, and click My Oracle Support
Login.
On the My Oracle Support page, follow the instructions to register as a new user.

11.2 What is a Bug or CR?
A bug is a defect in the existing code or functionality not performing as documented.
CR is the BEA-equivalent term for bug.

11.3 How can I get a fix to a bug? Can I get a patch for a bug?
Log in to My Oracle Support and download the patch for the bug. Use the Smart
Update tool to view and apply available patches. If a patch is not available from My
Oracle Support to fix your problem, open a case with My Oracle Support.

11.4 How do I obtain security advisory notifications?
Go to the Critical Patch Updates and Security Alerts page,
http://www.oracle.com/technology/deploy/security/alerts.htm to see
an updated list of advisories and the recommended remedies or patches. You may also
register at
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http://www.oracle.com/technology/deploy/security/securityemail.h
tml to receive notification of security advisories.

11.5 What is a private patch?
A private patch is one that My Oracle Support makes available to you as part of a
custom maintenance solution, and is not generally available from the My Oracle
Support Repository to all customers.

11.6 How do I download just a maintenance pack?
Maintenance packs are available individually for download to users with a valid
maintenance contract. To obtain a maintenance pack or service pack, log in to the My
Oracle Support Web site, http://www.oracle.com/support/index.html, and
choose Patches & Updates from the menu bar. Select the Oracle product and the
version and maintenance pack you want. See "Downloading an Upgrade Installer
From My Oracle Support" in Installation Guide for Oracle WebLogic Server for detailed
instructions.

11.7 What products can I patch using the Smart Update tool?
See Section 1.2, "Products Supported by Smart Update Version 3.3.0."

11.8 Do I need a support contract to download patches from My Oracle
Support?
You need a support contract to obtain a My Oracle Support account. You can
download patches only if you have a My Oracle Support account.
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This section guides you through the steps to complete three basic tasks and describes
the icons and labels used in the graphical interface:
■

Section A.1, "How to Generate a Maintenance Snapshot"

■

Section A.2, "How to Create a Custom Patch Profile"

■

Section A.3, "Smart Update GUI Glossary"

A.1 How to Generate a Maintenance Snapshot
Smart Update provides a mechanism for capturing information about your Oracle
product installation that you can send to My Oracle Support when reporting a
problem. This information is called a maintenance snapshot. This section guides you
through the steps of creating a maintenance snapshot.
To generate a maintenance snapshot, complete the following steps.
1.

Launch Smart Update:
Windows:
From the Start menu, choose Start > Programs > Oracle WebLogic > Smart
Update.
UNIX:
a.

Change to the MW_HOME/utils/bsu directory.

b.

Enter the bsu.sh command.
You do not need to log in to My Oracle Support to generate a
maintenance snapshot.

Note:

2.

In the Smart Update main window, in the panel labeled Target Installation, select
the Oracle product installation with which you are reporting a problem.

3.

Select a patch profile in the Manage Patches tab.

4.

Choose Patches > Patch Profiles > Save Snapshot.

5.

In the Save Snapshot dialog box, enter a file name for the maintenance snapshot,
and click OK.
The maintenance snapshot is a simple ASCII text file.

6.

Send the maintenance snapshot file to My Oracle Support. Use of e-mail is
preferred. But you can print the file and send it through postal mail, if appropriate.
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A.2 How to Create a Custom Patch Profile
If you want to limit the scope of a class or library path patch to a specific domain or
server, you need to perform the following steps.
Custom profiles have been deprecated as of Smart Update
3.3.0. Oracle recommends that you no longer use custom profiles.
Custom profiles increase the complexity of installing
installation-wide WebLogic Server patches.

Note:

1.

Create a custom patch profile, and apply the patch to it.

2.

Modify the start script for the corresponding domain or server to add a reference
to the custom patch profile.

This section provides a quick-reference aid that shows how to complete these steps,
and uses the example of a test engineer who has downloaded a patch and plans to test
the patch in a QA domain before incorporating the patch into a production domain.
To create a custom patch profile and point a domain or server at the patches applied to
the profile, complete the following steps:
1.

Download the patch from My Oracle Support into the patch download directory.

2.

Start Smart Update, log in to My Oracle Support, and select the Oracle product in
the Target Installation panel.

3.

Create a custom patch profile to which the patch is to be applied, using the
following steps:
a.

Choose Patches > Patch Profiles > New.

b.

Assign a name for the custom patch profile, and specify the initial set of
patches you want in the custom patch profile by cloning the contents of
another existing patch profile that exists for the target installation.
Example: The test engineer wants to run the QA domain at the same patch
maintenance level as the production system, but with the addition of the patch
downloaded in step 1. Therefore, the engineer creates the custom patch
profile, QADomainProfile, and clones the contents of the default patch profile
to it. Later, the engineer will apply the downloaded patch to this custom patch
profile.

Note that any existing installation-wide patches that have been applied to the
target installation are included in the custom patch profile by default.
After you click Create, the custom patch profile is displayed in a tab adjacent to
the tab for the default patch profile.
4.

Apply patches to, or remove patches from, the custom patch profile, as
appropriate.
Example: The test engineer now applies the patch that was downloaded in step 1
to the QADomainProfile custom patch profile.

5.

Before running the Start Script Editor, make backup copies of any scripts you plan
to modify.
Start Script Editor is not applicable for OSGi-based products
such as Oracle Enterprise Repository.

Note:
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6.

Choose Patches > Patch Profiles to open the Start Script Editor. You can modify
the appropriate start script so that it references patches in the custom patch profile.

7.

In the Start Script Editor dialog box, choose the custom patch profile you created,
the product for which you want to edit the script, and then click Open.

8.

Open the appropriate start script so that the domain, cluster, or server can run
with the patches in the custom patch profile. In the following table, domain_home
represents the path to the domain root directory.

To point the following at patches
applied to the custom patch profile Open the following script
Domain

Windows:
domain_home\bin\setDomainEnv.cmd
UNIX:
domain_home/bin/setDomainEnv.sh

All WebLogic Server instances in the
domain

Windows:
domain_home\bin\startWebLogic.cmd
UNIX:
domain_home/bin/startWebLogic.sh

All Managed Servers

Windows:
domain_home\bin\startManagedWebLogic.cmd
UNIX:
domain_home/bin/startManagedWebLogic.sh

One server instance

Windows:
domain_home\bin\startServerName.cmd
UNIX:
domain_home/bin/startServerName.sh

Example: Because the test engineer needs to point the QA domain to the custom
patch profile, the engineer opens the setDomainEnv.cmd script, which sets the
environment for all servers in that domain only. Unless you need to limit the scope
of a patch to a specific server instance, we generally recommend that you choose
the setDomainEnv for pointing to custom patch profiles.
9.

In the appropriate start script, create the environment variables that reference the
classes, extension directories, or library path patches in the custom patch profile to
which you want the script to point.
Patch classpath and other environment variables are set for each product
individually. You must set the appropriate variables for each product similar to the
variables set in WL_HOME\common\bin\setPatchEnv.cmd (Windows) or WL_
HOME/common/bin/setPatchEnv.sh (UNIX). These environment variables
are listed in the following table.
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To reference the
following patch

Define the following environment variable so it points to the
patches in the custom patch profile

Patch JAR containing
Environment variables to define:
classes to be interested into
PATCH_CLASSPATH
the WebLogic system
classpath
Example:
set WLS_PATCH_CLASSPATH=
%BEA_HOME%\patch_wls1030\profiles\NewProfile
\sys_manifest_classpath\weblogic_patch.jar
if "%PATCH_CLASSPATH%" == ""
set PATCH_CLASSPATH=%WLS_PATCH_CLASSPATH%;%WLW_PATCH_
CLASSPATH%;%WLP_PATCH_CLASSPATH%
Patch JAR containing
classes to be inserted into
the classpath of an
application deployed on
WebLogic Server

Environment variables to define:
WEBLOGIC_EXTENSION_DIRS
Example:
set WEBLOGIC_EXTENSION_DIRS=
%BEA_HOME%\patch_wls1030\profiles\NewProfile
\sysext_manifest_classpath

Native file to be inserted
into the system library
path (UNIX)

Environment variables to define:
PATCH_LIBPATH
Example:
PATCH_LIBPATH="${BEA_HOME}/patch_wls1030/profiles
/NewProfile/native"

Native file to be inserted
into the system library
path (Windows)

Environment variables to define:
PATCH_PATH
Example:
set PATCH_PATH=
%BEA_HOME%\patch_wls1030\profiles\default\native

The figure example shows the snippet used to change the setDomainEnv.cmd
script.

10. Ensure that any patch path variables you add to a start script precedes an

invocation to one of the other environment scripts. For example, if you add a patch
path variable definition to the setDomainEnv script, ensure that it is placed
before the invocation of the commEnv script.
If you use custom scripts in your environment that do not invoke the WL_
HOME\common\bin\commEnv script, or any of the other default scripts produced
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by the Configuration Wizard, you also need to modify the statements in your
scripts that set the class and library paths for your environment so that the
environment variables you have defined are properly inserted into those
statements.
For example, to set the WebLogic system classpath so that patch JARs in a custom
patch profile supersede same-named classes appearing later in the classpath, add
the PATCH_CLASSPATH variable as follows, shown in bold:
set WEBLOGIC_CLASSPATH=%PATCH_CLASSPATH%;%JAVA_HOME%\lib\tools.jar;
%WL_HOME%\server\lib\weblogic_sp.jar;%WL_HOME%\server\lib\weblogic.jar;
%WL_HOME%\server\lib\webservices.jar
11. Click Save.

For the patch to go into effect, each server instance that uses the patch must be
restarted.
12. If you subsequently decide to change the scope of a patch so that a different

domain or server uses the patch, or so that all servers and domains that run on an
installation use the patch, update the appropriate patch profile.
Example: When the test engineer approves the patch that has been tested in the
QA domain, the patch can then be promoted for use in the production domains. To
promote the patch, the test engineer does the following:
a.

Runs Smart Update, and selects the product installation used by the
production domain.

b.

In the Manage Patches tab, selects the default patch profile, and applies the
patch.

c.

Restarts the servers in the production domain.

A.3 Smart Update GUI Glossary
Table A–1 provides a key to the graphical symbols and labels used throughout the
Smart Update graphical interface.
Note: Starting from the Oracle Fusion Middleware 11gR1 release,
MW_HOME is the new term for BEA_HOME.

Table A–1
Screen or
Panel
Target
Installation

Smart Update Graphical Interface
Symbol

Description
Represents a Middleware home directory,
which may contain multiple Oracle
products. When you create a maintenance
snapshot, you must select the appropriate
Middleware home directory.
Note that the Smart Update graphical
interface can display only those Middleware
home directories for products that were
installed by the current system. Middleware
home directories on remote-mounted disks
are visible only if installed from the current
system.
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Table A–1 (Cont.) Smart Update Graphical Interface
Screen or
Panel

Symbol

Description

Target
Installation

Represents a product home directory. For
example, WebLogic Platform, or Oracle
Service Bus.

Target
Installation

Represents a specific installation of a
product, called the target installation. For
example, WebLogic Server Release 9.1.
A specific installation must be selected to do
the following:
■

View or download a publicly available
patch or patch set

■

Apply or remove a patch or patch set

■

Create or remove a custom patch profile

Downloaded
Patches panel

Displays the contents of the patch download
directory. Only patches not yet applied to a
given profile are displayed.

Downloaded
Patches panel

When you click a green arrow, it applies the
corresponding patch to the current patch
profile.

Manage
Patches tab

Displays the contents of each patch profile,
which is the set of patches applied to the
currently selected target installation. You
apply and remove patches from the Manage
Patches tab.
Note: To apply a patch and add it to the
current profile, click Apply next to that
patch or patch set in the Downloaded
Patches panel.

Manage
Patches tab

Displays the set of patches scoped to the
entire installation in a given Middleware
home directory, which corresponds to the
currently selected target installation.
If you have created additional patch profiles,
called custom patch profiles, each has its
own tab adjacent to the Default Profile tab.

Manage
Patches tab

When you click the red arrow, the
corresponding patch is removed from the
target installation and from the profile.
(Removed patches are listed in the
Downloaded Patches panel and can
subsequently be applied again if needed.

Patch
Application
Validation
dialog box

Displays conflicts that have occurred when
applying a patch, identifying the patches
that conflict with the one, or ones, being
applied. The conflict conditions that can
occur when applying a patch are described
below.
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Table A–1 (Cont.) Smart Update Graphical Interface
Screen or
Panel
Patch
Application
Validation
dialog box

Patch
Application
Validation
dialog box

Patch
Application
Validation
dialog box

Symbol

Description
The selected patch cannot be applied until
one or more other patches are first applied.
To resolve this conflict:
1.

Note the identifiers of the prerequisite
patches.

2.

Click Cancel, download and apply the
prerequisite patches, then apply the
selected patch

The selected patch requires that you first
remove one or more other patches that have
been applied. To resolve this conflict:
1.

Note the identifiers of the patches that
must be removed.

2.

Click Cancel and remove the identified
patches.

3.

Download and apply the selected patch.

4.

Re-apply the patches removed in step 2.

The selected patch cannot coexist with one
or more other patches that have been
applied To resolve this conflict, you must
choose which patch you want applied to the
target installation.
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BEA_HOME directory
Root directory into which Oracle software products are installed, represented by the
environment variable BEA_HOME.
Note that starting from the Oracle Fusion Middleware 11gR1 release, MW_HOME is the
new term for BEA_HOME (default is C:\Oracle\Middleware), and WL_HOME is the
term used for WebLogic Server home (default is
C:\Oracle\Middleware\wlserver_version.
bsu command
Command for running the Smart Update command-line interface. To run the
command-line interface, you must first change to the MW_HOME\utils\bsu directory.
See Chapter 8, "Using the Command-Line Interface."
custom patch profile
A patch profile the user can create in addition to the default patch profile. The use of a
custom patch profile provides a way to scope a set of patches to a subset of the servers
that run on a specific Oracle product installation; for example, an individual domain,
cluster, or server. Custom patch profiles are described in Chapter 5, "Activating
Applied Patches in Your Installations and Applications."
dependency violated
Conflict reported when you attempt to remove a patch upon which an existing patch
depends.
installation-level patch directory
Directory created by Smart Update that contains patch JAR files, native patches,
profile subdirectories, the patch registry, and the patch manifest JAR files.
invalidated patch
Patch that has been superseded or deprecated by My Oracle Support. Smart Update
automatically notifies you if any invalidated patches are detected in your patch
download directory. If you have applied an invalidated patch, Smart Update
highlights it in among the entries in your patch profile. You can click on the patch icon
to get information about replacing an invalidated patch, when a replacement is
available.
maintenance pack
A maintenance pack is an update to an existing release that includes solutions to
known problems and other product enhancements. A maintenance pack is not a
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maintenance snapshot

replacement for an installation of the Oracle product, but a package of changes and
additions to it.
Service packs are replaced by maintenance packs starting with WebLogic Platform 9.2
Maintenance Pack 1. Maintenance packs are replaced by version upgrades (Oracle
Patch Set releases) starting with Oracle WebLogic Server 10.3.x.
Note that you can no longer use Smart Update to apply or remove maintenance packs,
version upgrades, or service packs.
maintenance snapshot
Text file you can generate using Smart Update that contains details about the current
maintenance level of a target installation for a specific patch profile.
module patch
Patches that update common modules and product-specific modules.
mutually exclusive
Conflict that is reported when a patch you have selected to download or apply cannot
coexist with an existing patch for the target installation. The identifier of the existing
patch causing the conflict is provided.
Middleware Home (MW_HOME) directory
Root directory into which Oracle software products are installed, represented by the
environment variable MW_HOME. Starting from the Oracle Fusion Middleware 11gR1
release, MW_HOME is the new term for BEA_HOME.
native artifact file
Operating system-specific file, which may be a binary file or other resource.
out of sequence
Patch conflict reported when you are attempting to download or apply multiple
patches in the wrong sequence. When this conflict is reported, the proper sequence for
the selected patches is provided.
patch manifest JAR
File that references patch JARs that exist in the in the MW_HOME\patch_
wls1032\\patch_jars directory
passcode
Alphanumeric string provided by Oracle Support that you use, with a patch identifier,
to obtain a private patch. Private patches are no longer available for Smart Update.
patch
Between maintenance packs, patches are issued to provide bug fixes for individual
components. A patch does not provide product enhancements.
patch backup manifest
File, stored in the MW_HOME\patch_wls1032\backup directory, that contains files
that have been replaced as a result of having applied a patch. This directory holds files
required to restore an earlier patch maintenance level on your system.
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patch conflict
Compatibility problem that Smart Update has detected between the patch you have
selected to download, apply, or remove and the other patches that have been applied
to the target installation.
patch container
File that you download from Oracle Support that is kept in the patch download
directory. Contains patch content and metadata about that patch that is used for
validation.
patch JAR file
JAR file containing classes to be inserted into a classpath; for example, in the WebLogic
system classpath, or the classpath of an application deployed on WebLogic Server.
Patch JAR files are placed in the patch_jars subdirectory of the installation-level
patch directory. For more information about patch JAR files, see Section 5.1.5,
"Structure of the Installation-Level Patch Directories."
patch profile
Set of patches that have been installed in a specific Oracle product installation and that
serves as a mechanism for Smart Update to validate patches being applied.
patch set
Set of multiple patches made available for download and installation as a single entity.
Patch sets enforce the sequence in which member patches are applied to the target
installation; however, individual patches within a set may be selectively removed.
prerequisite not met
Conflict that may be reported when downloading or applying a patch. This conflict
occurs when you are attempting to download or apply a patch that requires other
patches be installed first. Identifiers of prerequisite patches are displayed when this
conflict is reported.
private patch
Patch that My Oracle Support makes available to individual users based on their
support requirements. Private patches are no longer available for Smart Update.
publicly available patch
A patch that My Oracle Support makes available anyone with a valid support contract.
From My Oracle Support, you can view and obtain detailed information about
publicly available patches for a specific Oracle product that is installed on your
system.
support ID
ID of the user account you obtain when you register with Oracle.
target installation
The currently selected Oracle product installation in Target Installation panel of Smart
Update.
validation
The process of determining if a patch has a conflict with other patches that are applied
to the target installation.
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